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ArchiCAD 19 NZE Template

The NZE Template has been developed by Cadimage Group especially for ArchiCAD customers
within New Zealand. This document is designed to help you install and use the template, and is
divided into 3 Sections:

Section One: Getting Started
Section Two: Template in Depth
Section Three: Renovation Template
Section Four: Appendix

To Get Started using the Template, you can read about the NZ Template Workflow on page 4.

Alternatively jump straight into Section Two: Template in Depth on page 10.
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Section One: Getting Started

NZ Template Workflow

The default template installed and used by ArchiCAD 19 has been designed as a great starting
point for a single story timber framed residential dwelling. It begins at a basic level allowing for
all common construction types in NZ and can be easily modified to allow for large residences to full

commercial premises.

We have designed the template to be used in a certain way that will automatically produce full
documentation sets using the correct weight of pens and at appropriate scales.

If your building is larger you will just need to adjust the Story Settings under Design>Story Setting
to allow for this. You can just click the Ground Floor & ‘Insert Above’ to add as many stories as

you require.
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When you first open ArchiCAD you will be presented with the Ground Floor SKETCH view which
has ALL layers turned on.
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With this view it means you are able to very quickly create a design without having to worry about
being in the relevant view. As long as all items placed are put on the correct layer, then the
subsequent Views and Layouts will automatically update showing only the relevant information.

There are 4 Elevation markers placed on the Floor Plan, your building should be modelled in this
area. They can be easily moved particular to your building size. By using these Elevations the
Views & Layouts are refencing these and will automate the documentation for you.

When designing your building you will be using the Design Tools which are 3D elements and can
be viewed in all Views. We have set up the Default of all these tools to use the correct Layer and
Pens. The Layers have been made to follow this Toolbox structure (Design, Document, More) so
all 3D Elements will go on Layers beginning with Des. For example:

Walls go on the Des: Walls layer

Roofs go on the Des: Roofs layer

Slabs go on the Des: Floors layer

Stairs go on the Des: Fittings General layer etc

When you begin designing it is best to start with the Default settings; we have also set up Favorites
for each tool that act as a great starting point. When you apply a Favorite it will set the correct
Setout, Layer & Pens and any minor modifications of the setout will retain those settings.

The only Tool that you need to be extra careful of which Layer you are using is the Object tool,
because an Object can do any number of tasks from structural to visualisation or documentation
and the layer that they use is critical. So Objects could use these layers:

Des: Furniture

Des: Fittings General

Des: Fittings Joinery

Des: Fittings Plumbing

With this in mind you could quite quickly model the entire structure of a house and place all relevant
Objects in the first view shown (Ground Floor SKETCH) without needing to worry about Scale or
Layers.

For Annotation you will need to use many of the Tools from the Document Toolbox; all these are
2D elements and only appear in the View you place them. For all these Tools there is a relevant



Layer starting with Doc for Document Toolbox. These Layers relate to what Layout or View you
would want to see the annotation on, for example:

e Doc: Floor - For Construction Floor Plans
¢ Doc: Sections - For Sections

e Doc: Plumbing - For Plumbing Plans

e Doc: Electrical - For Electrical Layout Plans

Now when you start to place annotation there is a high chance that they will overlap; ie the
Plumbing annotation will be in the same place as a Floor plan dimension and an Electrical set-
out description because none of these elements will be shown at the same time. For this reason as
you start to get further into detail in your design & begin annotating, it is best to use the relevant
saved View in the View Map.

The greatest benefit of using the appropriate View when designing or annotating is you get an
immediate notification of whether the Layer you are placing an element on is turned on or off. So if
it's off it may not be the correct Layer to be using in that particular View.

With this in mind we have created several Views that use the correct Scale, Pens & Layer
Combination. There are some general rules we have set for the View Map that are worth noting as
to how the output will be presented:

All Views have their own dedicated Layer Combination which makes it easy to manage.

Scales and are broken down to 4 categories:

e Detail 1:1-1:10,
e General Annotation 1:20-1:50
e General Annotation 1:100
e Site 1:200

Each Scale has its own Pen Set so the pens get thinner with larger scales. For example the
Window Pen will be 0.18mm at 1:50 and 0.13mm at 1:100.

Every View has an appropriate Model View Option designed for its use. Model View Options add
an extra layer of control beyond Layers & each View has been set to use the correct one. So there
is an Elevation Model View Option, a Section MVO and 2 Plan Model View Options that allow

you to show/hide the Window & Door marker.

With this in mind the output is based on those general rules and applied to documents:

e All Floor Plans are at 1:50
e All Site Plans are at 1:200
e All Elevations are at 1:100 so all 4 can fit on 1 Layout

As a result of these settings, all Views are placed onto A1 Layouts. This ensures that the 1:50
Floor Plan fills the page and 4 1:100 Elevations can fit on one page.

There are certain Views we could not create because these are placed specific to every project;
these Views include:

e Sections
e Details
e |nterior Elevations

These of course will be needed and the process of placing a Section Marker to your design,
creating a View from it and placing that on a Layout is as follows:



The Section Tool is in the Document Toolbox (as it is a 2D element); if you open its settings and
click Favorite you will see 2 Favorites:

. . = 2
B Section Default Settings b
avorites l Apply Favarites , b4 Default
* S* Gene } )
:’_v Save Current Settings as Favorite
Reference ID: Favorite Names:
Section Model Pens NZE
Mame: Section Uniform Cut Pens NZE

The Section Model Pens NZE uses the Fills & Pens as per the settings in all of the elements the
Section cuts through while the Section Uniform Cut Pens NZE Favorite uses the same pen for all
Cut elements. Regardless of which Favorite you choose New Viewpoint will be created in the
Project Map and the Marker will reference the Drawing on the Layout of the Section when you
document it and, of course, uses the Doc: Sections layer.

What this all means is that when you place it you can be confident that the Section Marker will
appear correctly on only the relevant Floor Plans. The NZE Template turns off Section Markers in
the Presentation & Finishes Plan, for example.

Once you are in the Section you will want to create a View as it is this View that will store the Scale,
Pens & Layers and this will be placed on a Layout. So in the Navigator, change to the View Map,
click the Section Folder and click the ‘Save Current View...’ button at the bottom:

| |

Now in this Save View window, the ID & Name will be based on the Project Map which should be
correct (your first section will be called A1: Section AA). In the General tab you will want to set up
your Section with the correct Layer Combination, Scale, Pen-Set & Model View Option:

So the Layer Combinations and Model View Options are really self-explanatory choosing
Sections for both. Since | want a 1:50 Section | set 1:50 as the scale & choose the appropriate
Pen Set which reflects the Scale chosen.

h Save View ?
* Identification
ID: By Project Map vl
MName: By Project Map v | Section AA
Source: A1 Section AA (Auto-rebuild Model)
* General
S Layer Combination: Sections W
@ Scale: 1:50 hd
B Structure Display: Entire Model b
¥ Pen Set: GA 1:50 NZE 18 W
B Model View Options: 09 Sections b
8 Renovation Filter: 00 MOT IM USE W




This means that when working on the Section from now on you can go to the View & be sure that
modifications you make here appear in the Layout Drawing.

To place it on the Layout go to the blank Sections Layout and open it. Then go to the View Map
and drag your newly created Section View onto the Layout:

Because of how the Drawing Tool is set up, this Section View on the Layout will automatically turn

Black & White as it will be using the GA 1:50 Printing NZE Pen Set.
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The same principle can be used for Interior Elevations, Details or any other extra Views you need
to create specific to your project. So as a summary: Project Map -> View Map -> Layout Book.

i o (8

Many of the Layouts you will require have been automatically made for you already including:

Ground Floor Plan
Foundation Plan
Framing Plan
Plumbing Plan
Elevations

So by just designing your building in the first Ground Floor SKETCH View, these Layouts will
populate themselves so you can immediately print a full set of documents which show only their
relevant elements.

This goes further than just the set of Documents; extra necessary elements like a Sheet Index or
Door & Window Schedule can be created automatically using your BIM model and it will work as
you would expect without any real need to change settings.



Section Two: Template in Depth

Full Template Explanation

We have covered all aspects of the Template in much more detail through the rest of this ArchiCAD
19 NZE Template document. It is structured from settings & setups that you will deal with from the
very start of a project through to the intricate aspects of the Template that make the ArchiCAD 19
NZE Template your most powerful start yet!

The NZE Template is based on the International ArchiCAD Standard & has been an ongoing
development since ArchiCAD 6.5. It is designed to give a solid starting point for all NZ Customers.

This Template is the one that is installed by default when you install the NZE version of ArchiCAD 19;
it is called ArchiCAD 19 Template.tpl.

This Template should form the basis of your office template. If the only thing you change at the
beginning is the title block information this will suffice, but you may want to modify many aspects
over time.

NOTE: Our recommendation is that you record your modifications, so that you can replicate them in
future versions of ArchiCAD Templates.
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Work Environment

The Work Environment is the layout of Toolbars & Palettes on your screen when using ArchiCAD,
this is independent of the Template and can be modified to your preferences. By default when your
first start ArchiCAD 19 it will appear using the Standard Profile 19 as described below.

The layout of ArchiCAD has been consistent for several years with the Palettes you are familiar with
remaining in static locations. For the purposes of the document we will highlight the Standard Work
Environment Profile which we recommend you use. You can find the Work Environment under
Options>Work Environment>Work Environment. The Standard Profile 19 is laid out like so:

W) File Edit View Design Document Options Teamwork Window Help ) _ax
D3| ed|oc[dsrle-l2af-~vEm-i-Eux =17 rsa@eda-le)m@-@ -m-lc-[a i
M{ T T T T T N =
Select Default Settings ﬂ £F ®Des: Wals 4 [5‘ & , = A Core Outside |, Y JEI_' [ exT: stud so... * P = -~ 2 o
B arow | 3T ‘ 2 || 5 g Untitied ~
£23 Marquee (] CmGround Floor SKETCH x | {G1North Elevation G Generic Perspective N e [0 Site
= _ [ Site Plan
% e;j (P N - t [ Site Bulk & Location
TEu| op-u aviegator [l Site Landscaping
IT oo (Sta ndard Toolbar) & p-up g Do s
| [ Plans
B vincen [l Ground Flaor SKETCH
§ cobmn I Ground Floor Plan
. N [l Ground Floar Presentation
7 Tab Bar (Mini Navigator Toolbar = ' Ecuriri e
<3, siab [ Ground Floor Foundation Plar
& s [ Graund Floar Framing Plan
d [P Ground Floor Reof Framing
@ roof [ Ground Floor Plumbing Plan
. [ Ground Floor Refected Cailin
wrsa = Toolbox Palette ) (Navigator Palette Yo |~ SSmirmwisecesce
ZZ2 skyiioht [ Ground Floar Bracing Plan
& e F ] sﬂ;:;ﬂnsfp\an
&> Morph - Eevatons
B oo Menu Bar Info Bar Palette ) ZortrEeton
o 4 1077 East Elevation
[y zone i 57 South Elevation
@ Mesh Dgt:i‘;':stﬁsvahnn
¥ Document - - I v
Fog— Status Bar (Quwk Options Palette) @ >
B Level ... Ei X
A Text ¥ Propesties
A1 Label ) Ground Floor SKETCH
. Fil g :‘; B
=
/ Line = 04 Building Plans No Markers
O o Settings... /
(7. Palyliine ick Opti - 3%
Drowes - T | -
4 Secti P @ 150
ecten e B  Entire Model
.. Elevat... ? GA1:50 NZE 18
Ao More S &2 150 aom v |CF @AE 8 (8] oo w0 < 3 B 04 Building Flans No Markers A
Enter First Node of Wall. v = = C100568 @ 123GB

You can find all the Toolbars and Palettes in the window menu:

e Window>Toolbars - Standard & Mini-Navigator applied
e Window>Palettes - Toolbox, Info-Box, Status Bar, Navigator & Quick Options

As a NZ ArchiCAD customer you are supplied with a selection of Cadimage Tools which require
some madifications to the Work Environment to appear. We have created a work environment to do
this automatically called ‘Cadimage Profile 19" which adds only items specific to the Tools.

For ArchiCAD 19 the Cadimage Work Environment is available from mycadimage.com. The Profile
is called “Cadimage Profile 19” and simply contains a Tool Scheme called Cadimage Tools 19. It
will modify the Toolbox and and Info bar contents to include the Tools. You can import this work
environment at Options>Work Environment>Work Environment or use the automatic Work
Environment installer.

When you start up ArchiCAD 19, you can choose to use the Cadimage Profile by choosing it from
the installed Work Environment list.

NZE Template: A How-To Guide -
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Story Settings
We have set Story 0 to R.L. 0.000 and named it Sea Level/Datum. Story 1 is set to R.L. 0.000 also:
B Story Settings ?

Mo. Mame Elevation Height to Mext xr

. 2 Roof 2450 2450 N

| 1[Bround Fioo] fo |2450

. 0 Sea Level/ Datum 0 0 |

Insert Above Insert Below Delete Story

Story 1 should be your lowest building level, either Ground Floor or Basement. This is set to the
same R.L. as the Datum level, when you know what the R.L. of your lowest level is you simply modify
this in the Height to Next field in the Story Settings highlighted with a red underline and the entire
project moves to the correct R.L.

We have also added a Roof level on Story 2, and set the Level Markers to only display for Story 1 in
Section and Elevation. These settings assume a single story building and a stud height of 2450mm.
A 2 Story building will be a Story inserted between Ground Floor & Roof & the height to next
adjusted to encompass the mid floor structure.

Project Map

The Story settings are reflected in Stories in the Project Map:

We have also placed 4 Elevation markers (North, East, South & West) close to the Project Origin
for optimum performance. Your building should be placed in this area & the Elevations adjusted to
suit your design.

=-ff Untited

- =[] Stories

L
[F
X
g
8

11 E-01 Morth Elevation {Auto-rebuild Model)
|10 E-02 East Elevation {Auto-rebuild Madel)

T A 107 E-03 South Elevation {Auto-rebuild Model)
107 E-04 West Elevation (Auto-rebuild Maodel)
=[] Worksheets
L@ T-01 Title (Independent)
S I O O I O B R RN | e S Details
£ =¥ 30 Documents
H H el DO Mimm ammme + A=l Clhadaus Foba embaiild BA-

NZE Template: A How-To Guide - 11
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The View Map &

The View Map is set up to mimic the Project Map and standard sets of documents you may
require, the general rule is that everything in the View Map is to be included in the Layout Book.
Everything else in terms of management of your project is done via the Project Map. Ideally all work
should be completed from a View in the View Map as this is what is to be documented and each
View controls the scale and overall appearance of the View.

The Site folder has 4 different Views based on the 0.Sea Level/Datum story with different Layer
combinations placed in the Site Folder:

e Site Plan — This uses the 0. Sea Level/Datum with Plan Site Layer combination at 1:200, this
is placed on Layout 101

o Site Bulk & Location - This uses the 0. Sea Level with Plan Site Bulk & Location Layer
combination at 1:200

e Site Landscaping - This uses the 0. Sea Level/Datum with Plan Site Landscaping Layer
combination at 1:200

o Site Services - This uses the 0. Sea Level/Datum with Plan Site Services Layer combination
at 1:200

The Plans folder are all based on the 1.Ground Floor story except for the Roof Plan which is based
on the 2.Roof Story set up as following:

e Ground Floor SKETCH — This uses the ALL Layer Combination to easily model and is
placed it in the ‘Ground Floor Sketch’ Layout at 1:50

¢ Ground Floor Plan — This uses the Plan Floor Layer combination at 1:50; this is placed on
Layout 102

e Ground Floor Interior - This uses the Plan Room Interior Layer combination at 1:50. (This is
not placed on a Layout)

e Ground Floor Foundation Plan - This uses the Plan Foundation Layer combination at 1:50;
this is placed on Layout 104

e Ground Floor Framing Plan - This uses the Plan Floor Framing Layer combination at 1:50;
this is placed on Layout 105

¢ Ground Floor Roof Framing - This uses the Plan Roof Framing Layer combination at 1:50.
(This is not placed on a Layout)

e Ground Floor Plumbing Plan - This uses the Plan Plumbing Layer combination at 1:50; this
is placed on Layout 106

e Ground Floor Lighting/RCP — This uses the Plan Reflected Ceiling Layer combination at
1:50; this is placed on Layout 107

o Ground Floor Electrical Plan - This uses the Plan Electrical Layer combination at 1:50.
(This is not placed on a Layout)

¢ Ground Floor Bracing Plan - This uses the Plan Bracing Layer combination at 1:50. (This is
not placed on a Layout)

¢ Roof Plan - This is based on the 2.Roof story from the Project Map and uses the Plan Roof
Layer combination at 1:50, this is placed on Layout 108

NZE Template: A How-To Guide - 12



ARCHICAD 19

The Elevations folder in the View Map contains the 4 Elevations from the Project Map. These are
all using the Elevations Layer Combination and are set to 1:100. All 4 Elevations are placed in order
onto Layout 301.

The Details & Sections folders in the View Map are empty to facilitate you to create your own
Details or Sections for your design and place the required Views neatly in the folders.

The 3D folder in the View Map contains contains some useful 3D views which will work with any
building placed in the area between the Elevations on the Floor Plan. These include:

¢ Generic Axonometric — this is a view of the entire space between the Elevation markers
shown as a standard axonometric 3D view (45° to the top left & top right)

¢ Generic Perspective — this is a view of the 3D window shown as an OpenGL perspective
with shading.

e Generic Perspective H/L —this is a view of the 3D window being shown in Hidden Line view
S0 no shading or textures, and uses the internal engine so less responsive in navigating

e Sketch Koh-I-Noor - this is the same view as ‘Generic Perspective’ but is using the Sketch
rendering engine using the Koh-I-Noor view

o The 3D Document Perspective Shadows view shows the entire 3D window in a clever ‘Fit
in Window’ view shown in a simplistic Line & Shaded colour view

o The 3D Document Aerial Shadows view shows the entire 3D window in a parallel view
shown from directly above to give a Plan appearance. This is represented in a shaded view
with Shadows for a Sun study/Shadow diagram.

The Title Block folder contains the T-01 Worksheet and is placed on each Master Layout. The
idea here is if you change the title in one place, it updated all Masters and subsequent Layouts.

;---_|'I'|ﬁe Elocks
P L T-01Tite

The Schedules folder contains 2 Electrical schedule which work seamlessly with the Cadimage
Electrical tool but can be easily modified to accommodate most methods of creating an Electrical
Layout. The folder is particularly useful to place extra Schedules which you will find in the Project
Map or when you create your own like the Cadimage Door & Window schedule.

—J.[_] Schedules

...... Electrical Legend

‘-[Ef] Electrical Schedule

The Indexes folder contains the 2 Project Indexes used in the Layout Book in the NZE Template:

e Sheet Index — This lists all Layouts in your Layout book on an A4 sheet
e Issue History — This lists all Layouts issued through the life of the project

NZE Template: A How-To Guide - 13



ARCHICAD 19
The Layout Book &2

The Layout Book in the NZE template is set up similar to the View Map, so a lot of the Views listed
above are placed individually onto Layouts using their correct Scale & Layer combination. It is
organized into folders containing the type of drawings within, eg: Plans, Section etc.

The Subset folder have been organized so that their ID is assigned automatically, if their order is
changed, the Folder ID will update. The default folders are set up as:

Plans
Sections
Elevations
Details

3D

ok~ n -

Each of these subset folders have been also set up to automatically assign all included Layouts a
Layout ID based on the folder they are in. So all pages placed in the 1.Plans folder will have a 3 digit
ID starting from 101 upwards, the 2.Sections folder will set all Layouts to 201 upwards etc. This is
controlled in the Subset folder settings:

Selected: 1 Editable: 1

w Subset Identification

ID: [ Do not indude this Subset in 1D sequence

() Custom ID

MName: |

¥ IDs of Items in this Subset

() Continue using ID assignment of Upper Levels
@ Customize ID assignment

| Prefix & IDs of Upper Levels Preview:
1

Add Prefix for this Subset

Selected: 1 Editable: 1

w Identification And Format

Layout ID: Do not indude this Layout in ID sequence

' Use Automatic Book and Subset ID assignment
T

NZE Template: A How-To Guide - 14



Views are placed on each Layout:

ARCHICAD 19

The default Layout Book contains 15 Layouts, 2 of which are blank. The below diagram shows what

Organizer - Layout Editor n
[2, firs o @ B (=5 [ &
E--ﬂh Untitled # | |Tree by subset 3

- Site

;g Plans EI'H Untitled
----- [ Ground Floor SKETCH E Sheet Index _
..... [ Ground Floor Plan - E Document Transmittal
..... [y Ground Floor Presentation N | ‘ 3 i#1-[8 Ground Floor Sketch Plan
----- [ Ground Floor Interior , E@ 1 Plans _
----- [z Ground Floor Foundation Plan | | : E 101 Site Plan
..... [ Ground Floor Framing Plan | | ~ [-[[8 102 Ground Floor Plan _
..... [ Ground Floor Roof Framing H.,‘l | = 8 103 Ground Floor F‘resent—;.mnn Flan
..... [ Ground Floor Plumbing Plan | | o E 104 Ground Floor Fnun!jahnn Flan
----- [ Ground Floor Reflected Ceiling Plan ‘:| I E 105 Ground Floor Framujg Plan
_____ [ Ground Floor Electrical Plan | % E 106 Ground Floor Plumbing Plan
..... [ Ground Floor Bracing Plan G (g 107 Ground Floor Reflected Ceiling Plan
..... [y Roof Plan — . =~ 1[1.8 Foof Plan

..... [} Sections EI@ 2 Sections .

[)-["} Elevations P 220 _Sechnns
J{C1 Morth Elevation E@ 3 Elevations _
}{C1 East Elevation . & w8 3'3'_'-' Blevations
J1C1 South Elevation E‘ 4 Details _
J{C1 West Elevation oo [ 401 Details

----- Detals [ 5 30 _

-3 3D »[+-[g 501 Perspective
----- figd Generic Axonometry - EIG Masters _
----- £ Generic Perspective E 'i'j F‘Drgalt

The Sheet Index Layout uses the A4 Portrait master and contains the Sheet Index Project Index as
found in the View Map. This Sheet Index does not include the Sheet Index, Document Transmittal or
Ground Floor Sketch Plan as they are not contained within one of the 5 folders.

EE |Sheet Index | Import...

] Drawing List hd Export...

w Criteria / Sheet Index

( Criteria Yale ) andyfor

¥ Subset is ArchiCAD 19 NZE Template 61 Plans ar

= Subset i ArchiCAD 19 NZE Template 6'2 Sections ar

¥ Subset s ArchiCAD 19 NZE Template 6'3 Elevations or

E Subset i ArchiCAD 19 NZE Template 64 Details ar

= Subset i ArchiCAD 19 NZE Template 615 3D

This criteria can be modified in the Sheet Index Settings to include/exclude additional Layouts.

The Document Transmittal sheet is part of the Revisions functionality and is described in the

Revisions section at page 44.

The Ground Floor Sketch Plan is a basic Layout that has All layers turned on for initial concept.

NZE Template: A How-To Guide - 15
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Master Layouts

Following on from the Layout Book, we include 4 Master Layouts by default which are the 4
standard paper sizes. This list should be expanded by offices as the appearance and variance of
Layouts depends on Office standards. The 4 Master Layouts we have are:

A1 Landscape A2 Landscape
Used for Architectural/Construction drawings Used for Architectural drawings
= -
Il
i ==
A3 Landscape A4 Portrait
Used for Presentation/Concept drawings Used for Sheet Index & Document Transmittal

et

Each of these Layouts use the same Title which is located in the Project Map & View Map as a
Worksheet called T-01 Title. This allows you to make edits to the title in the Worksheet and the
changes will appear in all the layouts:

B@ Elevations
@ E-01 Marth Elevation (Auto-rebuild Madel)
{037 E-02 East Elevation (Auto-rebuild Model)

*

{031 E-03 South Blevation (Auto-rebuild Model)
{07 E-04 West Elevation (Auto-rebuild Model)
Interior Elevations

[E] Worksheets

v

Detalls

[& 30 Documents

%l 30 Document Shadows (Auto-rebuild Model)
¥ SR

D RUOOH#

EE EETTITLED #layout g s Contact Ful Address)
FEgL e e #Client Full Name et

— _EEWSION £ ] N ) .
g #PrOJeCt Name HONE: #Contact P hane Mumbe?’
Bao N 4 A #Cortact Fax ]

-_ fSUED:: . Bins.201 L gg:%g éﬂgreﬁsst Contect E-mail
+DJ ROJECT &7 I - _contscteb

‘Ruedwo

&

The # items are Autotext which have been set up to be the correct font and size. These are filled in
automatically using the Project Info dialog found at File>Info>Project Info.
NZE Template: A How-To Guide - 16
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Publisher

Following on from the Layout Book, the Publisher allows you to save or print multiple Layouts out in
one go. Four publisher sets have been created for the different output options you may require:

MNavigator - Publisher Set

(2, fis [
Publisher Sets

& ANl Layouts to 1 FOF
% All Layouts to Individual PDFs
I Al Views to DWG

34 BIMx Hyper Model

All Layouts to 1 PDF
This contains the entire Layout Book folder set to PDF format and ‘Merge to one PDF file’ has been
checked at the bottom. This will produce a single PDF file with multiple pages.

All Layouts to Individual PDF’s
This is the same as the ‘All Layouts to 1 PDF’ Publisher set described above, but has the checkbox
for ‘Merge to one PDF file’ unchecked

All Views to DWG

This Publisher set contains the entire View Map with the format set to DWG and using your default
DWG translator for export.

BIMx Hyper Model

This Publisher Set has been set up to Save Files as a single file with the format set to BIMx which is
to be uploaded. You will need to Sign in using your Graphisoft ID and set it to use Private Folder so
it is not available for everyone globally to download. Name the project appropriately as it will appear
on the client’s/contractor’s tablet device.

B Publisher Set Properties ?
Publishing method: Upload BIMx Hyper-model [
User details
Mame: Jonny Breen
Company: Cadimage Group
Upload to (®) Public Domain

() Private Folder: {5000.00 MB)

Project details
Mame: Untitled - BIMx Hyper Model
1

MNote: Information set in Project Info and Project
Preview will be added to Hyper-model details.

|:| Save local copy: CiWsersuser 1'\Documents

cocs

You can retrieve the link for the project to send on at https://bimx.graphisoft.com/ .
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Keyboard Shortcuts

As part of the Standard Profile 19 we have used the International list of shortkeys which work on
most ArchiCAD’s globally. You can see the full list by going to Options>Work
Environment>Keyboard Shortcuts and choosing Show Shortcut List in Browser:

w Keyboard Shortcut Preview

The currently assigned keyboard shortcuts can be listed in a web browser application.

Show Shortcut List in Browser

For convenience we have listed the most commonly used ones here on 2 pages so this can be
printed and the relevant side used at your desk:

Command Mac Shotcut PC Shortcut
Select All Command + A Ctrl + A
Copy Command + C Ctrl + C
Drag Command + D Ctrl + D
Rotate Command + E Ctrl + E
Find & Select Command + F Ctrl + F
Layers Dialog Command + L Ctrl + L
Multiply Command + U Ctrl + U
Tool Settings Command + T Ctrl + T
Paste Command + V Ctrl + V
Drag a copy Option (while dragging) Ctrl (while dragging)
Drag multiple copies Command + Option Ctrl + Alt
Up/Down a Story Command + up/down arrow Ctrl + up/down arrow
Navigate to next tab Command + Tab Ctrl + Tab
Navigate to previous tab Command + Shift 4+ Tab Ctrl + Shift + Tab
Trim Command + Click Ctrl + Click
Select element Shift + Click Shift + Click
Pick up Properties Option + Click Alt + Click
Inject Properties Command + Option + Click Ctrl + Alt + Click
Magin Wand Space + Click Space + Click
Floor Plan View F2 F2

3D View F3 F3

View Selection in 3D F4 F5

Layout View F7 F7

Trace Reference Shift + F2 Alt + F2
Cancel Operation Esc Esc

Quide Lines " (key above tab) " (key above tab)
Create Guide Line Segment Shift 4+ Shift 4+
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Default Functions

Much like the Work Environment the Functions of ArchiCAD can be controlled independently to your
personal preference.

As part of the Work Environment we have turned on several functions which allow you to use
ArchiCAD productively, while some functions have remained turned off because they can otherwise
be cumbersome. You can find these in the Standard Toolbar:

|Ig. L=l sl = NG s R‘ﬁﬂ]ﬁrfﬁﬁE'|':§:'

We have listed these below:

e Permanent Guide Lines - Turned ON to aid with drawing

e Snap Points - Turned ON and set to show Mid-Point

e Snap Guides - Turned ON and set to show orthogonal guide lines
e Tracker - Turned ON to aid with dimension input

e Grid Snap - Turned OFF as it restricts your graphical input

o Trace Reference - Turned OFF as required view needs to be selected
o Gravity - Turned OFF as placement will be done by settings
e Element Snap - Turned ON to easily draw from element to element
e Suspend Groups - Turned ON to easily edit individual elements

e Cutting Planes - Turned OFF as its placement is design dependant

2D Window

This has been set to White. You can set the background colour at View>Grid & Editing Plane
Options>Grids & Background:

LW Grids & Background ?

Construction Grid / Mudge
i Main Grid A, Grid
Spacing: Steps: Spacing: Steps:

Rotated Grid 3 %, g ®
% Local Origin:
..... Background: Grid Lines:
0 L 50 | |
Y: |0 T |0
# #

Rotation Angle:

2, | 4500000

As highlighted in the Grids & Backgrounds window, the Grid has been turned on in the 2D window
and uses a light grey line with 2 metre spacing to give you an idea of scale when drafting.
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On Screen View Options

How elements appear on screen in the 2D window is largely determined by the On Screen View
Options; this can be found under View>On Screen View Options. These generally do not print.

We have turned the relevant items ON as listed below:

¢ Clean Wall & Beam Intersections - this cleans up the joints of Walls & Beams

¢ Roof Pivot Lines - shows the pivot line for Roofs, doesn’t print

o True Line Weight - shows the true line weight & how it will print

e Vectorial Hatching - shows hatching as applied by the settings of elements
e Marker Range - shows the entire range of Sections & Elevation markers
e Drawing Frames - shows the corners of Drawings to know their extents

¢ Master Items on Layout - shows the Master Layout items on normal Layouts

o Fill Handles - shows direction arrow of Fills if option is chosen

e Textbox Handles - shows the corners of Text to know its extents

e Figure Handles - shows the corners of Figures to know its extents

o Spline Handles - shows the points that help define the Spline shape

Some optional elements that we have turned off by default are:

o Wall & Beams Reference Lines — Highlights the Reference Line & its direction

e Bold Cut Lines - Highlights all Cut lines as Bold

e Highlight Source Markers - Highlights Section, Elevation & Detail source Markers
e Hide Drafting & Editing Aids - Hides Spline and Fill handles

e Trimming Bodies - Highlights volume under roofs red.

3D Window Settings

The 3D engine has been set to use OpenGL which  ['g SR Sritgs ?
has had major advancements in ArchiCAD 19 to

be smoother and faster than ever. Transparency
and Sun Shadows are both ON which means the Mod: ® 5|6
windows ARE transparent in 3D. The background

3D Modeling Engine: OpenGL W

Window Size (pixels): — 1 1001
has been set to a pale blue to represent the sky. v —
Backaround Calor: (®) Uniform
Contours have been turned Off, which means all (O Asin PhotoRendering
elements in the 3D view will not have an outline, [ contours:
giving a cleaner 3D view. Line Weight: ® @ ®
Vectorial Hatching
. . |
All Hotspots are shown to give you maximum v Transparency
. . Sun Shadows with Contours
editing options.
at i
GOL Object Hotspots: (®) Enable 2D Hotspots
(") Show 3D Hotspots only
Advanced Options... Cancel
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Filter Elements in 3D

All stories are being shown in the 3D window. If a
Marquee is placed and the ‘Show Marqguee in 3D’
option is used then only elements within the Marquee
are shown.

If using the Cutting Planes or Marquee, the 3D
window now shows the Elements Attributes on the
Cut Surface rather than black — this provides the
ability to produce 3D Details and see the intersections
of elements using Priority Based Connections.

The only Element that is not shown in 3D is Zones, this
is because they can get in the way when navigating
inside a building as you won't be able to zoom or
select elements as easily inside the house. You can
turn Zones on for the purpose of Energy Evaluation
under View>Elements in 3D View>Filter and Cut
Elements in 3D...

ARCHICAD 19

Stories to Show in 30
(®) Infinite

() From Story 0, Sea Levelf Daktum

to Story 0, Sea Level! Datum

Trim Elements to Story range

Marquee Effect
(@) Inside Marguee

(" Outside Marguee
Trim Elements to Marguee

Show elements:

Cut Surface Displa
{®) Use Element Attributes

D Custom

Paint-04

Element Types to Show in 3D

O

All Types

wall

Colurmn
Beam
Window
Doar
Skylight
Object
Lamp

Slab L\x’
Mesh

Roof

Shell
Curtain Wall
Zone

Marph

SRE(VLLoE DAY=
EOXEREEEEEEE XXX X
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The Toolbox

The Toolbox in ArchiCAD has been organised into 4 sections:

Select - The Arrow tool to select items and Marguee tool to narrow selection
Design - 3D tools, building elements that will appear in all views

Document - 2D tools, will only appear in the view that they are placed

More - Mixture of 2D and 3D tools that are rarely used in design process

This section will go through the individual Tools and their default set-up as we have designed them

to work within the New Zealand Template. We will review only the relevant settings like Story linking,
Layer & default setup/sizes. Generally each Tool has a corresponding saved Favorite of its default
settings which you can easily restore.

Select Tools

Arrow This is how you select anything in ArchiCAD. It can be easily gotten to by holding SHIFT
k  which temporarily activates the Arrow tool. Or hitting Esc twice will revert to the Arrow Tool.

Marquee This Tool is an aid to help narrow your selection in Plan or the 3D window.

Design Tools

Wall Default Setout is using the EXT Stud 90 composite by default and its height is linked to its
% Home Story and the Story above. It is using the Des: Walls layer. Its Reference Line is set to
Core Outside and uses Building Material Surfaces. Favorite stored as EXT: Stud 90 Pb NZE.

Door Default Setout is using the ArchiCAD Door 19 and its sizes are 810x2025 with a 25mm frame
resulting in a 760x2000 door leaf. The Anchor point is set to Sill to current story which is set
E— to zero so it sits on the ground level. Default Setout stored as ‘ACd’ Favorite.

Window Default Setout is using the ArchiCAD Window 19 and its sizes are 900x1500. The Anchor
point is set to Header to Current story so that all windows align with their headers and this is
El set to 2200 by default. Default setout stored as ‘ACw’ Favorite.

Column Default Setout is a 90x90 Timber Post using the Timber — Structural Building Material. Its
height is linked to the Home Story and the Story above. It is on the Des: Columns layer. It
ﬁ uses the Building Material Surface. Default setout saved as ‘Timber 90sq NZE’ Favorite.

Beam Default Setout is 140x90 Timber Beam using the Timber — Structural Building Material. The

= Surface is set to override with Wood — Pine Grained Horizontal except for the end which is
Wd — Oak. It is saved as 140x90 Exterior Beam NZE Favorite so appears dashed on the
Home Storey and solid on the Story above.

Slab Default Setout is using the Floor: Concrete 100 composite. It is set to start on the F.F.L of the
current story & grow down with the Reference Plane on top. It is set to show the Building
Materials surface of Concrete - 02. Favorite is ‘100 Conc Slab NZE’

Slab Edge Default Setout is set to use the Cadimage Counter Edge Slab Edge which has been set
up to give a 20mm bullnose to the top & bottom edges of the Slab. It is set to show on Home
Story Only & is on the Des: Fittings Joinery layer. Favorite is saved as‘Bullnose NZE’
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Stair - Default Setout is to use ArchiCAD’s Stair L-Shape 19, this has been set to 2710 tall. It
shows on Home & One Story Up and its Layer is set to Des: Fittings General as it is set it out
as a Timber stair. This has been stored as a Favorite named L-shape Stair NZE.

Polystair — Default Setout is set to start with a straight flight as 1200mm wide. This is a Concrete s
) tair where the base starts at the Current Story and is also set to show on Home & One Story
Up. Itis on the Des: Fittings General layer. Default is saved as Polystair NZE Favorite.

Railing - This is set to use the Cadimage Railing object which appears as a Timber balustrade on
m the Des: Fittings General layer. Because these are generally part of the Stair tool this has
been set to show on Home & One Story above. Favorite is stored as Railing NZE.

Roof Default Setout is set to be a simple roof; using Timber — Roof Building Material set to 90mm
Q\ thick. It has Surface overrides of Metal - Corrugated Sheet on top and Paint - Light Gray as
" the side material. Its layer is Des: Roofs and favorite saved as ‘Variable Roof NZE’

Shell This is set to use a simple Shell instead of a Composite. It's set to use the Timber — Roof
A building material & set to 300 thick. It is set to show on Stories All Relevant Stories and Floor
plan Display Projected with Overhead. Its default layer is Des: Roofs. Favorite is ‘Shell NZE’

Skylight Default Setout is set to use the Skylight Pivot Hung 19 and size is 600x1600. It no longer
has a layer as Skylight display is now controlled by Model View Options. The default setout
has been saved as a Favorite named ‘Skylight NZE’

Curtain Wall The Curtain Wall has been set up so the Frame & Main panel is set to use the Building
&5  Material Surfaces (Aluminium & Glass — Blue). The distinct panels are set to be Aluminium.
Its Layer is set to Des: Walls as it is seen as a type of Walls. Favorite is Cutain Wall NZE.

Morph Default Setout is to use the Building Material Plywood & start with zero offset from the current
& story. Its Layer is set to Des: Furniture as the Morph tool’s most common use is for bespoke
pieces of fitted furniture. Favorite is stored as ‘Morph NZE’

Object Default Object is set to use the Armchair NZE Favorite which uses Armchair 01 19 &is on
E the Des: Furniture layer and set to appear on Current Story only. The surfaces are set to Use
Objects Surfaces. Favorite is stored as ‘Armchair NZE’

Zone Default Setout is using 01 Residential and Recreation category which uses Zone Stamp 2 19
[y as set within Options>Elements Attributes>Zone Categories. Its base is linked to current
story & top is unlinked. Set on the Des: Zones layer. Favorite is stored as ‘Zone NZE’

Cabinet Default Setout is set to use the Cadimage Cabinet tool which is set as a basic 1200x200
unit with 2 doors. Its default Layer is set to Des: Fittings Joinery and is set to show on Home
Story Only. Favorite has been stored as ‘Basic 1200 Floor Unit NZE’

Electrical — (if owned) Default Setout is set to use the 2D Switch Component which is a good
& starting point for Electrical Setouts. It is set to show on Home Story Only. Its Layer is set to
Des: Fittings Electrical as these components will turn into Wall Plates as the design
progresses which have a 3D appearance. Saved as ‘Component Switch NZE’ Favorite.

Mesh Default Setout is set to Solid Body with a thickness of 1000mm. Its Building Material is set to

& Soil — Soil and it has a top surface override of Grass - Green. Cover Fill is turned on to be
Grass. Ridge selection is set to Show User Defined Ridges. The default Layer is set to Des:
Site Mesh Existing as the first Mesh you will draw is going to be the existing Site. This default
has been stored as a Favorite called ‘Mesh NZE’.
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Document Tools

Detail Element Default Setout is set to the Cadimage Timber Member which will be using the Doc:
= Sections Layer. Since it is a 2D element it will only appear in its current Story.

Dimension Default set out is set to Dimensions NZE Favorite. This is the Linear method with
£%  crosshair appearance & 400mm witness lines. These use the Annotation pens and Layer is
set to Doc: Floor.

Level Dimension Default Setout is set to be 4mm in size and use 2.5mm Arial text. It has an
= Opaque background and the Marker + Text is using Annotation pens. Layer is set to Doc:
@ .
Floor. Favorite has stored as Level NZE.

Text Default Setout is 2.5mm high Arial text & aligned to the left using Pen 86 (Annotation Text —
A notes) and an Opaque background. Layer is also set to Doc: Floor. Favorite has stored
default as Text NZE.

Label Default Setout is set up similar to the text tool using 2.5mm high Arial text while the Label
uses Pen 85. It is set to show only a Leader Line with no Frame & is on the Doc: Floor layer.
Favorite has default as Label NZE.

s |

Fill Default Setout is set to use the Grid 600x600 Fill using Pen 18 as the Fill pen and Pen 19 as
¢Z.  the Background Pen. It is linked to Project Origin and uses Layer Doc: Finishes. Favorite has
stored Default as 600x00 Fill NZE.

Line Default Setout is set to use a Solid Line using Pen 85 and are on the Doc: Floor layer.
~  Uniform Settings for Line Tools is turned on. Favorite has stored default as Line NZE.

Arc/Circle Default Setout is set up the same as the Line tool because of Uniform Settings for the
Line Tools using Solid Line and Pen 85 on Doc: Floor Layer. Favorite has stored default as
Arc/Circle NZE.

Polyline Default Setout is set up with Uniform Pen setting so set up the same as the Line tool using
Ied Solid Line and Pen 85 on Doc: Floor Layer. Favorite has default stored as ‘Polyline NZE’

Drawing Default Setout is set use the ArchiCAD Layer & uses the 1:50 Printing Pen Set so that
drawings when placed on a layout turn Black & White according to Printing Pen set. Favorite
has stored default as Layout 1:50 NZE.

Section Default Setout is set so that it Creates a New Viewpoint as no Sections are placed in the
Default Template and set to show a unlimited depth horizontally and Vertically. Its Model
Display is set to show the Cut Fills of all elements as in their settings & use their pens. The
Marker itself is set to the Doc: Sections layer and it saved as ‘Section Model Pens NZE’,

Y
—

Elevation Default Setout is set so that it Creates a New Viewpoint and its ID is set to E-05 since 4
Elevations are already placed on Plan. Ilts Model Display is set to show Uncut Elements as
‘Own Surface Colors Shaded’ & Cut Elements (likely to be the Mesh) as their Cut Fill
settings. The Marker is set to the Doc: Elevations layer. Favorite has default stored as Elev
Color NZE.

Interior Elevation Default Setout is set to be a Square room with 4 Elevations placed on all 4
Orientations (N,E,S,W) and each Create a New Viewpoint. The Model Display is set to Own
Surface Colors (Non Shaded). The Marker is set to use use Doc: Elevations Interior. Favorite
has stored default as ‘Interior Elev Colour NZE'.

™
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Worksheet Default Setout is set to use Worksheet NZE Favorite. This Creates a New Worksheet
7 with the Marker referring to the First Placed Drawing on a Layout. Its Layer is set to Misc:

Hidden as Details should be the only one left on Plan.
Detail Default Setout is set so the ID is left blank & name is just set as ‘Detail’. The Marker refers to
B the First Placed Drawing on a Layout & the Layer is set to Doc: Details. Favorite has stored

default as ‘Detail NZE'.

Change Tools Default Setout is set to show the Cloud & Marker. The ID has been set to ‘1’ and the
Name has been left blank for you to fill in and is set to go on the Doc: Floor Layer. Favorite
has stored default as ‘Cloud + Marker NZE'.

More Tools

Grid  Default Setout is set to show entire Grid Line as a Double Dashed Line with markers both
@  sides. Itis setto show on All Stories and in 3D also. Its Layer is set to Doc: Grids. Favorite
has default stored as ‘Grid NZE’'.

Wall End Default Setout is set to use Wall End Chamfer with a 500mm length. (CHECK!) It is set to
Fit to Wall so will be the same height. It doesn’t have a Layer as it will belong to the Walls
layer. Favorite has stored default as ‘Structural NZE'.

Corner Window Default Setout is set so the Left Side of the window to have a 90 degrees angle.
% The Anchor Point is set similarly to the Window tool with Header to Current Story set at 2200.
Favorite has default stored as ‘Left Corner Window NZE'.

Lamp Default Setout is set to use the new Cinema 4D lights and is set to 100% brightness on the
9 Des: Lamps Layer. Favorite has default stored as ‘Halogen DL NZE'.

Radial Default Setout is set to show the Centre Point of a curve and the Radial Dimension is
¢ displayed in the Label-like style. Its Layer is set to Doc: Floor. Favorite has default stored as
‘Radial NZE'.

Angle Default Setout is set to show the Inner dimension between 2 lines with an Arrow indication &
=t dimension displayed horizontally. Layer is also set to Doc: Floor. Favoite has default stored
as ‘Angle NZE'.
Spline
-~ Default Setout is set with Uniform Pen setting so set up the same as the Line tool. Favorite
has stored default as ‘Spline NZE'.

Hotspot Default Setout is set to use Pen 20 (which doesn’t print) so set to use ArchiCAD Layer.
4  Favorite has default stored as ‘Hotspot NZE".

Figure Default Setout is set to use the Import: Site Aerial Layer. A Favorite cannot be stored to this
as this requires a Figure to be set already.

Camera Default Setout is set to show Camera at eye level (1700); this will need adjusting as per the
J* R.L of your Floor Level adjusts. Sun is set to show as ArchiCAD settings.
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Floor Plan Display

Most of the tools have been set to Home Story Only in their Show on Stories setting in Floor Plan:

- @ Floor Plan and Section

FLOOR PLAN DISPLAY
Show on Stories Home Story Only
Floor Plan Display Symbolic Cut

ARCHICAD 19

This is because the most efficient workflow in ArchiCAD is to construct the model on a per story
basis as they would arrive on site as opposed to using multi-story projected walls.

The Floor Plan Display is generally set to Symbolic Cut which means that items placed on a Story
will show regardless of where they are in relation to the Projected Cut Plane.

The Floor Plan Cut Plane is only useful when you have sloping walls or multi-story walls with
windows at mid floor, i.e. a wall in a stairwell. As these walls are the exception rather than the rule, it
is simpler to set these specific walls to Projected and keep all the rest set to Symbolic cut. You

can set up the Cut Plane at Document>Floor Plan Cut Plane.

The Design tools are 3D and can be seen on multiple stories so they have been set up like so:

Wall
Door
Window
Column
Beam

Slab
Slab Edge
Stair
Roof

Shell

Skylight

Curtain Wall

Morph

Object
Mesh

- Show on Stories Home Story Only & Floor Plan Display Symbolic Cut

- Floor Plan Display Symbolic
- Floor Plan Display Symbolic

- Show on Home Story Only & Floor Plan Display Symbolic Cut

- Show on All Relevant Stories and Floor Plan Display Projected with
Overhead, this is set up for Exterior Beams (pergola members, external steel
structure etc. Beams show dashed on Home story, Solid one story above,

and nowhere else))
- Show on Home Story Only
- Show on Home Story Only

- Show on Home & One Story Up, this will show the stair on its modelled
story and on the story it goes up to (i.e. one story up).

- Show on All Stories Floor plan Display Outlines Only, this will show the
roof slabs as solid lines on the Home Story and dashed elsewhere

- Show on All Relevant Stories and Floor Plan Display is set to Projected

with Overhead.

- Show on Stories is now controlled by MVO’s and Project Preferences
- Show on All Relevant Stories and Floor Plan Display Symbolic with

Overhead

- Show on Home Story Only and Floor Plan Display Outlines Only
(assuming you will use the Morph Tool to create a new object — furniture etc)

- Show on Home Story Only
- Show on Home Story Only
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Layers

The Layers in ArchiCAD 19 have been developed to be as simple as possible aligning their names
with the Toolbox and Tools. They are organised into 4 main categories:

1. Des - This stands for Design and relates to the 3D tools in the Design Toolbox. These
are the 3D modelled elements that appear in multiple views.

2. Doc - This stands for Document and relates to the tools in the Document Toolbox.
These are for 2D annotation elements that appear only in the view they’re placed.

3. Import - This is for Importing any additional info like Site Aerials or Surveys. This relates to
external files like DWG’s or JPEGs that are manually imported to your file.

4. Misc - Thisis for additional information like hidden elements or Mark-Ups. Best used for
Solid Element Operators or Design Images which you don’t want to output.

As highlighted these relate to the Toolbox that the Layers refer to. And as documented above all of
the tools are set to use their correct layer so Layer management should be a simple process.

A Layer Matrix has been included in the Appendix at the end of this document.

Layer Combinations

The Layer Combinations are based off the possible outputs of documentation you may require.
The result being that every View has its own specific Layer combination showing and hiding the
relevant information which can then be placed directly onto a Layout.

With each view using the Layer Combination it makes the project easier to manage. You can
update Layer Combinations which will update any View using them, rather than managing the
individual Layers shown on each View.

The Layer Combinations are organised into 6 main sections. Layer Combination is most critical in
Plan where a single Story could produce 20 different documents. This doesn’'t happen as much with
Sections, Elevations or Schedules so they only have 1 or 2 Layer Combinations. The categories
are listed below:

1. Details - This single Layer Combination is for use for Detail Views

2. Elevations - There are 2 Layer Combinations for Elevations — Exterior & Interior
3. Sections - This single Layer Combination is for use with all Sections

4. 3D - There are a few Layer Combinations to show different levels of detail
5. Key - This single Layer Combination is for producing a Key Plan

6. Plan - There is 15 Layer Combinations, each purpose is clearly defined

The Layer Combination table on the next page describes the intended use of each Layer
Combination along with the Annotation Layer to use specific to that Layer Combination along with a
suggested Model View Option to use in conjunction with the Layer Combination.
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Layer Matrix

18487 OwoIyaly|

Elevations
Sections

Elevations Interior|
3D: Building Envelope
3D: Model Simple

3D: Model ALL

Plan Bracing

Plan Electrical

Plan Finishes

Plan Fire

Plan Fittings
Plan Floor|

Plan Floor Framing

Plan Feundation

Plan Plumbing

Plan Present./Furniture

Plan Roof

Plan Reflected Ceili

Plan Roof Framing

Plan Room Interior|

Plan Site

Plan Site Bulk & Lecation

Plan Site Landscaping

Plan Site Services

This Layer Matrix shows what Layers are visible in the Layer Combinations as set in the standard ArchiCAD 19 Template.
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Model View Options

The Model View Options take over from where Layers stop. Layers are simple in that it can only
turn an entire element off or on. But if the element is quite complex, like a Door which belongs to
the Wall, Layer control is not sufficient. We may want to see the Door hole only, or turn off the Door
leaf, or not see the Door Number.

These different parts of the Door are not on their own Layers (and cannot be made to do so) so we
need another way of controlling them which is where Model View Options comes in. You can find
these in Document > Set Model View > Model View Options

We have 11 Model View Options, each with different settings (and different purposes):

e 01 Site — for Site Plans or larger scale drawings (1:200, 1:500)

e 02 Drafting — designed for detail line work

¢ 03 Building Plans Markers — for GA documentation with Door & Window markers ON
¢ 04 Building Plans No Markers — as above but with Markers off

e 05 Ceiling Plans — For Reflected Ceiling Plans

e (06 Room Layouts — for mid scale detail Layouts i.e 1:25 Kitchen, Bathroom etc
o 07 3D Exterior — for external 3D views (handles & taps set to off)

e 08 3D Interior — for Internal 3D views (handles & taps set to on)

e 09 Sections — for Sections

o 10 Elevations — for Elevations

e 11 Electrical - for creating Electrical Plans

A great way of thinking of Model View Options is changing the appearance of one element in
different views. Some common elements that are controlled by Model View Options are:

e Doors, Windows and Skylights

e Door & Window Markers

¢ Fill control/override

e Zone Stamps

¢ Handles and knobs in 3D

¢ Minimal Space around objects & joinery
e Stairs and Railings

e Electrical symbols

e Cabinetry

Each Model View Option has a large list of settings which we have set up and listed these in the
table on the next page. These can be modified to your needs otherwise and good to use and you
can simply choose which Model View Option you require by their name.
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Options for Construction Elements
Show Beam | Entire Beam X | x X | x| x| x| x| x
Reference Axis X
Contour line X
Show Column X X | x X X | X X X X | x
Show Curtain Wall | Full X X | X X X X | X X X X | x
Show Mark-Up Entires X | X | X | x| x| x| x| x| X | X | X
Door Options | Show on Plan X | x| x X | x| x| x| x| x
With Markers X X
Show Opening Only X X
With Contours X
Window Option | Show on Plan X | x| x X | x | x| x| x| x
With Markers X X
Show Opening Only X X
With Contours X
Skylight Options | Show on Plan X | x| x X | x| x| x| x| x
With Markers X X
Show Opening Only X
Hide on Floor Plan X
Override Fill Display
Override Fill Background
Override Cut Fills X X
Override Drafting Fills
Override Cover Fills X
Override Zone Fills X X | x X
Hide Zone Stamp X
Miscelleaneous settings for Library Parts
Show Minimal Space X X
Lamps & HVAC Symbols | Realistic X | x| x| x X | x | x| x| x| x
Reflected Ceiling
X
Plan
Hide Furniture Knobs in
X X X
3D
Hide Taps in 3D X X X
Hide Door Handles in 3D X X X
Show Opening Lines on | Doors X | X | x| X X X | x| x| x
Window X X | x X X | X X X X | x
Skylights X | x | x| x X | x | x| x| x| X
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Model View Options Appearance

The following is the same Room showing the same Layers with the first 10 MVO applied:

01 Site 02 Drafting

03 Building Plans Markers 04 Building Plans No Markers

g\880

./

05 Celiing Plans 06 Room Layouts

07 3D Exterior 08 3D Interior

09 Sections 10 Elevations

?
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Pens

All Pen Sets are based on the ArchiCAD International Standard and are divided into 3 main sections;
the Tool pens (1-140), the Building Material Pens (141-180) and the New Zealand Pens (181-194)
which are to aid with drafting & accommodate traditional workflows.

Generally we have edited pen weights to be consistent with ISO pen weights which goes as follows
0.13mm, 0.18, 2.5, 3.5, 5.0, 7.0 & 10.0. All Pens have been based on 1:50, then amended as in
table below.

1:10 1:50 1:100 1:200
0.18 0.13 0.1 0.1
0.25 0.18 0.13 0.1
0.35 0.25 0.18 0.13
05 0.35 0.25 0.18
0.7 05 0.35 0.25
1 0.7 0.5 0.35
2 1 0.7 0.5

The Pen set is organised into 3 main sections:

ArchiCAD Pens

RN
]
T
o (S

|

W B

Building Material Pens

|
EEEEEEEEEEERNEREEEE
B mmmmmmn | | New Zealand Pens
CEEEE | EEEEEe]

The first 180 pens are standard ArchiCAD pens specific to the Tools, each column is a tool and
each row is for a certain function. Combined they result is a very structured format which is best
explained in the diagram below. Generally the first 180 pens are set correct for the scale of the
output.

General Pens

BB openings
BB objects
~ |EIFIBEE Annotation
T EEE Annotation Text

w
=
[
o
o
o
General Pen .-
Cut Structural .-

Cut Non-Structural .-.
Symbols & Seperators .IED.

Outlines .li@.

BB ENE structural
| |EIT1T] Electrical
EEEE | Fils

| 171 1 | Backgrounds
"7 symbols

Fill ren BT

" IS stairs
I roof

_ | I Mesh

_ | SIS/ zone

" | EEE Vechanical
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Then we have the new 40 Building Material Pens in two horizontal rows; the top row being the
outline & the bottom row being the fill pen.
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cut Line [IHNEETHEEEENEENNNEN
Cut F3.11 | 50 O T A I S ™

Then we have 4 rows of NZE Specific Pens:

10 Drafting pens — colour & description describes pen weights no matter what scale you print
from 0.001 to 3.0mm.

10 Grey Scale pens - different shades of grey (5%-90%) that are grey in the Printing Pensets also
and all set to a thickness of 0.1mm.

1 Revisions pen - for adding Revision Clouds using Change Tool and markups which stays
Red in the printing pen sets also.

2 ‘Twink’ pens - one thin (0.25mm) and one thick (1.0mm), designed to use when you want
to remove a rouge line that you cannot resolve in the model.

10 Colour pens —these are set to dark shades of colour and are the only pens that retain their
colour in the Printing Pensets & all set to 0.1mm.

4 Colour pens —these 4 pens are a continuation on the Colour Pen set and commonly
created by customers for light shading in Plan & Elevation.

9 Renovation Pens - 3 for each Renovation status — Existing, Demolition and New. These 3 pens
are the Line override, Fill Pen override and Fill Background Pen override.

Grey

o

...-..l Greyscale Pens

Revision Pens| —t— Twink Pens
Colour Pens 4‘_I_f_f_'_ Presentation Pen

Renovation Pens! ] Q
Existing | Demo | New

60% Grey
70% Grey
80% Grey

20% Grey
90

Ll 30% Grey
50% Grey

40% Grey

As an additional help we have included a full table of all the pens in the 4 pen sets as a large table in
the Appendix which you can use as a reference.
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Default Pens

As a helpful guide, we have included a list of the most commonly used default Pens in the NZE
Template and their Pen-weights at 1:100, for example.

Pen No. | Pen Name GA 1:50 Use
1 | General - General 0.13 Drawing Marker Pen
2 | 2D Elements - General 0.18 Section uncut pen
3 | Openings - General 0.18 Door and Window Elevation Pen
4 | Objects - General 0.18 Object Plan Pen
5 | Annotation - General 0.25 Window Marker Text Pen
6 | Annotation Text - general 0.35 Marker text pen
11 | Stairs - General 0.18 Stairs Plan Pen
18 | Fills - color 1 0.25 Light Grey Fill Pen
19 | Backgrounds - color 1 0.18 White Background Pen
20 | Symbols General 0.25 Change Tool Revision Clouds
25 | Annotation - Markers 0.5 Markers Plan Pen
27 | Walls - Cut Structural 0.35 Wall Section Pen
28 | Columns - Cut Structural 0.5 Column Plan outline
36 | Structural - Cut Construction 0.5 Detai Elements Outline
43 | Openings- Cut Non-Structural 0.35 Door and Window Plan Pen
45 | Annotation - Arrowheads 0.35 Label Arrowhead Pen
46 | Annotation text - bold 0.35 Label Tool Text
53 | Mesh - Cut Non-Structural 0.35 Mesh outline
66 | Annotation Text - normal 0.18 Dimension Text
72 | Roof - Symbols and Separators 0.18 Roof Plan Pen
75 | Mechanical - Plumbing 0.18 Sanitary Plan Pen
77 | Electrical - General Lighting 0.18 Lamp Tool Plan Pen
85 | Annotation - Dimlines 0.18 Dimension and Label lines
86 | Annotation text - notes 0.18 Text Tool Pen
87 | Walls - Outlines 0.18 Wall Elevation Pen
89 | Slabs - Outlines and Cover Fills 0.18 Slab Plan Qutline
90 | Beams - Outlines 0.18 Beam Plan Outline
91 | Stairs - Outlines 0.18 Stairs Plan pen above breakline
93 | Mesh - Outlines and Cover Fills 0.18 Mesh Cover Fill Pen
116 | Structural - Hatching 0.13 Detail Elements sub-lines
155 | Timber - Cut Lines 0.35 Timber Wall Outline
173 | Earth - Cut Fills 0.13 Mesh Section Fill
175 | Timber - Cut Fills 0.13 Timber Wall Fill Pen
222 | ChowHill Orange 0.13 Used in Title Blocks
245 | Reno Demo - Cut Fills 0.35 Demolition Fill Pen

All of these Pens have been named appropriately in the Pen Set. If you hover over a Pen while in the
Pen table you will see the name and weight of the pen listed at the top of the Pen Set:

3 0.13mm / 0.37 Pt Openings - General
- HBE ]
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Pen Sets

There are 8 Pen Sets in the NZE pen sets, which are broken down to 4 Pen Sets based on scale.
Each Pen set has a GA set and a Printing set which is described below.

Detailing MZE 19
Detailing Printing NZE 19
GA 1:100 NZE 19

GA 1:100 Printing NZE 19
GA 1:50 Printing MZE 19
Site NZE 19

Site Printing NZE 19

e Detailing NZE 19 - designed for Detail work at 1:1 to 1:10.

e GA1:100NZE 19 - designed for G.A. Drawings, Floor Plans, Sections etc at 1:100.
o GA1:50NZE19 - designed for G.A. at 1:50 and maybe 1:25 Room Layouts.

o Site NZE 19 - designed for G.A. Site Plan drawings at 1:200 — 1:500.

The Pen sets have been labelled as GA (General Annotation) or Printing. The GA Printing Pen sets
uses colours specific to each tool (EG: All windows are Orange & Furniture is Green) so that it's
clear to read on screen. These are described in detail above.

The Printing Pen Set turns all these colours to Black & White mainly for outputting of documents,
except the Revisions pen and Colour pens row.

ENEEEEEEEEEEEEEEEE B
ENEEEEEEEEEEEEEEEEEE
ENEEEEEEEEEEEEEEEEEE
N EEEENEEEEEEEEEEEEE

BN EEEENEEEEEEEEEEEEE
TN EEEEEEEEEEEEE

|
-

H NN |

Pen Sets in the View Map

The Views saved in the View Map use the relevant Pen Set; so a 1:50 Floor Plan has its scale set
to 1:50 and uses the GA 1:50 NZE 19 Pen Set. When this View is placed onto a Layout, the
placed Drawing of this View on the Layout uses the GA 1:50 Printing NZE 19 Pen Set. Below is a
list of some examples of Views and the Pen Set used:

Ground Floor Sketch = GA 1:50 NZE 19 (assuming you want 1:50 floor plans)
Site Plan = Site NZE 19

Site Bulk & Location = Site NZE 19

Site Landscaping = Site NZE 19

Ground Floor Interior = Detailing NZE 19 (we assume this is for large scale plans)
All remaining Floor Plans = GA 1:50 NZE 19 (assuming you want 1:50 floor plans)
Elevations = GA 1:100 NZE 19 (assuming you want 1:100 elevations)
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Building Materials

Building Materials were introduced in ArchiCAD 17 and are integral to the workflow of ArchiCAD.
This Attribute contains all the information necessary for defining a physical Building Material and
how it should appear in all Views and interact with other Building Materials and in Energy Evaluation;

o Fill Type

e Pen Colour

¢ Fill Orientation

e Surface Material

e Intersection Priority
e Tags and Categories
e Physical Properties

There are 73 Building Materials in total organised into 20 Building Material groups in the Pen Set
tables; these Pens have been listed below with their intended use:

Building Material Pens Descriptions

These Building Materials are used by the Wall, Column, Beam, Slab, Roof, Shell, Morph and Mesh
Tools. Although some of these Tools use the standard ArchiCAD Pens so that they can define
different Pen Weights for the Plan, Section & Elevation appearance of these Tools.

However, Composites use Building Materials entirely and therefore, use these Pens more frequently
in all Views. The outline Pen Weights (141-160) are set up for each Building Material depending on

its density while all the Fill pens (161-180) are set to 0.13mm at 1:50.

No. Description NZ Use Description

141/161 Membranes - Cut Lines/Cut Fills Tanking, Roofing Membranes
142/162 Plastic membranes - Cut Lines DPC, DPM

143/163 Masonry blocks - Cut Lines Block-work (Aerated and Masonry)
144/164 | Tiling - Floor & Wall - Cut Lines Wall, Floor Tiling

145/165 Glass - Cut Lines Glass

146/166 | Metals - Cut Lines Other Steel and Lighter Steel
147/167 Ironwork - Cut Lines Structural Steel

148/168 Brickwork - Cut Lines Brickwork

149/169 Lightweight Concrete - Cut Lines Topping Slabs

150/170 Reinforced concrete - Cut Lines Structural Main Concrete

151171 Solid plastics - Cut Lines Hard Insulation

152/172 Tiles - Roof - Cut Lines Concrete Roof Tiles (Slates, Shingles)
153/173 Earth - Cut Lines Dirt

154/174 Thermal Insulation - Cut Lines Batt insulation (soft Insulation)
155/175 | Timber - Cut Lines Timber, Framing and Structural
156/176 Plasters - Cut Lines Exterior Rendering, Solid Plasters
157,177 Gypsum - Cut Lines Plasterboard

158/178 | Stones - Cut Lines Stones

159/179 | Air Space - Cut Lines Air Cavity

160/180 Particle - Cut Lines Sheet board i.e. Ply, Particle board
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Below is a table of all the Building Material Pens in the NZE Template. The only item to be aware
of is the Buildings Material Priority — this defines its role within Priority Based Connections.

No. | Building Material Fill Surface Priority
1 Brick Common Brick Brick-Red 540
2 Brick - Structural Common Brick Brick-Common Bond 720
3 Brick - Finish Common Brick Brick-Brown 640
4 Masonry Block - Structural Masonry Block Brick - White Natural 730
5 Masonry Block - Filler Masonry Block Brick - White Natural 520
6 Concrete Lightweight Concrete Concrete 02 890
7 Concrete - Structural Lightweight Concrete Concrete 02 905
8 Concrete Block - Structural Concrete Block Concrete 04 750
9 Concrete Block - Filler Concrete Block Concrete 04 530
10 | Reinforced Concrete - Structural Structural Concrete Concrete 04 920
11 | Reinforced Concrete - Prefab Structural Concrete Concrete 04 920
12 | Insulation - Glass Wool Insulation 01 Oaint - Pink Blush 710
13 | Insulation - Fiber Batt Insulation Insulation - Fibreglass 410
14 | Insulation - Mineral Hard Insulation 02 Insulation - Cellulose 440
15 | Insulation - Mineral Soft Insulation 02 Insulation - Cellulose 430
16 | Insulation - Plastic Hard Rigid Insulation Paint - Royal Blue 550
17 | Insulation - Plastic Soft Rigid Insulation Stucco - White Fine 450
18 | Insulation - Thermal Brake Concrete 01 Insulation - Cellulose 820
19 | Fire Proofing Fire Proofing Stucco - White Fine 610
20 | Membrane - Vapor Barrier Waterproofing Paint - Ivory Black 530
21 | Membrane - Waterproof Waterproofing Paving-Asphalt Dark 906
22 | Membrane - Rainproof Waterproofing Paint - Dark Gray 470
23 | Timber - Roof Background Fill Paint Titanium White 800
24 | Timber - Floor Background Fill Paint Titanium White 705
25 | Plywood Plywood Wood - Mahogany Vertical 815
26 | Fiberboard Plywood Wood-Pine Grained Horizontal 340
27 | Tile - Roof Roof Tile Roof Tiles - French Red 840
28 | Tile - Floor Foreground Fill Tile - Light Brown 150x150 230
29 | Plaster - Lime Sand Plaster Stucco - Yellow Rough 620
30 | Plaster - Gypsum Plaster Stucco - White Fine 210
31 | Gypsum Plasterboard Gypsum Stucco - White Fine 320
32 | Gypsum Plasterboard - Waterproof Gypsum Stucco - White Fine 330
33 | Aluminium Foreground Fill Metal-Aluminium 940
34 | Iron Air Space Metal - Iron 930
35 | Steel Steel Metal - Steel 950
36 | Steel - Structural Steel Metal - Iron 960
37 | Steel - Stainless Steel Metal - Stainless Steel 970
38 | Titanium Zinc Air Space Metal - Zinc 800
39 | Stone - Structural Cut Stone Stonework - 13 710
40 | Stone - Finish Cut Stone Sonte - Marble Carrara White 630
41 | Plastic - Solid Foreground Fill Plastic - Laminate 240
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42 | Air Space Air Space Air 0
43 | Air Space - Frame Air Space Air 310
44 | Gravel Gravel Stonework - 13 130
45 | Glass 25% Glass - Clear Fast 550
46 | Soail Earth Eart - Brown 110
47 | Water Background Fill Water - Pond 110
48 | Sand Cut Stone Eart - Brown 120
49 | Timber - Structural Wood Wood - Pine Grained Horizontal 725
50 | GENERIC - INTERNAL CLADDING 25% Paint - Titanium White 200
51 | GENERIC - EXTERNAL CLADDING 25% Stucco - Yellow Rough 600
52 | GENERIC - EXTERNAL FILLER 50% Concrete 04 500
53 | GENERIC - EXTENDED MEMBRANE 50% Stucco - Red Rough 800
54 | GENERIC - PREFABRICATED 25% Concrete 04 900
56 | GENERIC - ENVIRONMENT 25% Eart - Brown 100
57 | GENERIC - INTERNAL FILLER 25% Paint - Titanium White 300
58 | GENERIC - INSULATION 25% Insulation - Solid Brown 400
59 | GENERIC - STRUCTURAL 50% Concrete 04 700
60 | Tile - Wall 25% Tile - White Matte 150x150 250
61 | Timber - Wall Foreground Fill Paint Titanium White 700
62 | Insulation - Plastic Hard Foundation Rigid Insulation Paint - Royal Blue 905
63 | Timber - Foundation Background Fill Wood - Pine Grained Horizontal 906
64 | Timber - Batten Background Fill Paint Titanium White 695
67 | Floor - Carpet Background Fill Carpet 01 230
68 | Solid Operator Air Space Glass - Clear Fast 999

You can change the Outline, Fill or Surface used by any of the primary Building Element Tools within

their settings under Floor Plan and Section and Model settings without having to create a new

Building Material:

— = ?
Y Wall Default Settings :
Fawvorites. .. Default
» @t Geometry and Positioning
- & Floor Plan and Section
- FLOOR PLAN DISPLAY a
Show on Stories Home Story Only @
Floor Plan Display Symbolic Cut =
- CUT SURFACES
¥ Override CutFil Pens Both #z W
# W cutFil Foreground Pen 0.13 mm 107 |:|
W cutFil Background Pen 0 mm 127 |:| v
- & Model
Override Surfaces:
e o Junction Order:
o . g '=::Q;|:| 8 z
Titar te Log Details...
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Composites

There are 70 composites made for the NZE Template, all of which have been made specific to
New Zealand construction. These are organised with several prefixes and some terms have been
shortened so they fit in the small box in the Info Bar like so:

x

Default Settings <@>Des: Walls M= | F = Core Outside =9 EXT: Stud 90... *
. 3 » b|| »

There is a list of 5 Prefixes which explain the purpose of the Composite organised like so:

e Ceiling- For Ceilings and lining underneath a mid-floor. Used by Roof & Slab tool

e EXT - Stands for EXTERIOR, for use with Wall tool to differentiate Exterior Walls

e Floor - All Types of Floor Construction and for use only by the Slab tool

e INT - Stands for INTERIOR, for use with Wall tool only to differentiate Interior Walls
e Roof - For Roof Structures and able to be used by Roof and Shell tool

There are other suffixes to each composite which describe its setout. To help understand these we
have listed them below:

e Insul - Stands for Insulation — uses relevant insulation for construction (wool/rigid)
e B/L - Stands for Battens + Lining; this is used in Floor & Roof composites

e Stud - Stud means non solid Timber Wall Framing, used for Walls

e Pb - Stands for Plasterboard, the finishing layer to Ceilings and Walls

o Ply - Stands for a Plywood finish to the Floor composites

With all that in mind here is the full list of Composites available in the NZE V19 Template:

Composite Use Thickness
Ceiling: 140 Insul + B/L Slabs/Roofs | 185
Ceiling: 36mm Battens + Pb Slabs/Roofs | 45
EXT: Block - 10 Series Walls 90
EXT: Block - 15 Series Walls 140
EXT: Block - 20 Series Walls 190
EXT: Conc Block 20 Series Walls 190
EXT: Conc Block 25 Series Walls 240
EXT: Concrete 100 Walls 100
EXT: Concrete 120 Walls 120
EXT: Concrete 150 Walls 150
EXT: Concrete 200 Walls 200
EXT: Hot Block 15 Series Walls 140
EXT: Hot Block 20 Series Walls 190
EXT: Hot Block 25 Series Walls 240
EXT: Precast-150 Walls 150
EXT: Stud 140 Walls 140
EXT: Stud 140 Insul Walls 140
EXT: Stud 140 Insul Pb Walls 150
EXT: Stud 140 Pb Walls 150
EXT: Stud 140 Thermal Pb Walls 150
EXT: Stud 90 Walls 90
EXT: Stud 90 Insul Walls 90
EXT: Stud 90 Insul Pb Walls 100
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Composite Use Thickness
EXT: Stud 90 Pb Walls 100
Floor: 20mm Ply Slabs 20
Floor: 20mm Ply Insul Slabs 60
Floor: 40mm Insul Slabs 40
Floor: Concrete 100 Slabs 100
Floor: Concrete 100+40mm Slabs 343
Floor: Concrete 120 Slabs 120
Floor: Concrete Pod Slabs 358
Floor: Joists 1404+20mm Ply Slabs 160
Floor: Joists 1404+-20mm Ply B/L | Slabs 205
Floor: Joists 140+20mm Ply Slabs 160
Floor: Joists 140+20mm Ply Slabs 205
Floor: Joists 190+20mm Ply Slabs 210
Floor: Joists 1904+20mm Ply B/L | Slabs 255
Floor: Joists 1904+20mm Ply Slabs 210
Floor: Joists 1904+20mm Ply Slabs 255
Floor: Joists 240+20mm Ply Slabs 260
Floor: Joists 240+20mm Ply B/L | Slabs 305
Floor: Joists 240+20mm Ply Slabs 260
Floor: Joists 2404+-20mm Ply Slabs 305
Floor: Topping 100 Slabs 100
Floor: Topping 70 Slabs 70
INT: Block - 10 Series Walls 90
INT: Block - 15 Series Walls 140
INT: Block - 20 Series Walls 190
INT: Conc Block 20 Series Walls 190
INT: Conc Block 25 Series Walls 240
INT: Concrete 100 Walls 100
INT: Concrete 120 Walls 120
INT: Concrete 150 Walls 150
INT: Concrete 200 Walls 200
INT: Stud 140 Walls 140
INT: Stud 140 Insul Walls 140
INT: Stud 140 Insul Pb Walls 160
INT: Stud 140 Pb Walls 160
INT: Stud 70 Walls 70
INT: Stud 70 Insul Walls 70
INT: Stud 70 Insul Pb Walls 90
INT: Stud 70 Pb Walls 90
INT: Stud 90 Walls 90
INT: Stud 90 Insul Walls 90
INT: Stud 90 Insul Pb Walls 110
INT: Stud 90 Pb Walls 110
Roof 140 No Covering Roof/Shell | 190
Roof 90 truss only Roof/Shell | 90
Roof 90 truss/battens/bp Roof/Shell | 140
Roof: 90 Insul Roof/Shell | 90
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Complex Profiles

We have included a large list of Complex Profiles with the NZE Template to give you a good
starting point on modelling. This list could easily be expanded as the power of Complex Profiles is
immense. We use it for pod foundations, structural members, timber beams etc.

ARCHICAD 19

Complex Profiles Use
Brick Wall Walls
Belt Ledge Walls
Precast Double T Beams
Precast Beam T Beams

Precast Inverse Tee

Walls + Beams

Precast Beam | 02

Beams

Precast Beam | 01

Beams

Z Beam

Beams + Columns

C Section - Lipped

Beams + Columns

C Section - Plain

Beams + Columns

Z Section Column

Columns

Equal Angles Beams + Columns
Joist Beams + Columns
RHS Cold Closed Beams + Columns
T Steel Beams + Columns
Universal Column Columns

Window Ledge Walls

Crown Cornice Walls

Brick Wall w Footing Walls

Joist Stretchy Beams

Slab Edge Thickening Beams

Slab Foundation Beams

Slab Thickening Beams

Slab Foundation Footing Beams

Beam Stretchy Beams

Slab Pod Edge Beams

Slab Pod 300 rib Beams

Slab Pod 100 rib Beams

Slab Foundation Thermal 01 Beams

Slab Foundation Thermal 02 Beams

Slab Foundation Thermal 03 Beams

There is a large list of Standard Steel Sizes available within ArchiCAD 18 that you can import as
Complex Profiles from Options>Import Standard Steel Sizes...

It G

Selected Profiles:

2 < |

Name
T uB1z0x14
T usi1s0x18
T ueizox16
T usizoxis
T uBisoxzz

=T nooanvao

I Standard Steel Profile Database
Country Code: G2
[l New Zealand v I
Geometry:
T 1/H shape vl o G4

Dimensicns
150 x 75 A
155 x 75
173280
1752 80
178280

100 . 00
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Surfaces

Surfaces were remade in V18 to work with the CineRender engine into ArchiCAD 19. There are the
standard 130+ surfaces included in the standard NZE Template to choose from. They have been
slightly renamed and been remade to perform better in Rendering.

GEMERAL Metal - Fence Chainlink A WRoof Ties - Asphalt Shingle Gray
B Eark - Deciduous Metal - Gold R.oof Ties - Asphalt Shingle Green &%
B Erick - Aged Natural g E PMetal - Iron Roof Ties - Cedar Shingle Light T
B Erick - Brown Eumm Metal - Mickel B Roof Tles - Dutch |
B Eridk - Common Bond ez Metal - Perforated Small Dots B R.cof Ties - French Brown -
B Erick - Flemish Bond = Metal - Stainless Steel BRoof Ties - French Red Tt
W Erick - Red b Metal - Zinc W R.oof Ties - Spanish |
B Erick - Red HerringBone s B [ Paint - Alizarin Carmine B siding - Dark —
B Erick - Running Bond g2 B [Praint - Anthradte Siding - Light —
B Eridk - Soldier Bond pit: 2 Paint - Bordeaux Siding - Medium —
W Erick - Stack Bond EEE B @ Paint - Cadmium Crange B 5tone - Granite Gray
B Erick - Surface Colour Paint - Cadmium Yellow Bstone - Granite Red
Brick - White Matural 222 Paint - Celadon M stone - Limestone Fine
B Carpet -01 B Faint - Cobalt Blue B 5tone - Marble Black
B carpet -02 B Faint - Dark Gray Stone - Marble Carrara White
Carpet - 03 B Faint - Forest Green B 5tone - Marble Pink
Ceiling - Tile-300x300 =+ Paint - Glossy White Stone - Sandstone 01
Ceiling - Tile-600x1200 B= Paint - Golden Beige Stonewark - 02 e
Ceramic - Parcelain WPaint - Golden Ochre Stonewark - 12 T
Concrete -02 B Faint - Tvory Black Stonewaork - 13 B
Concrete - 04 Paint - Lead Cxide Yellow B 5tucco - Beige Rough
B Ezrth - Brown Paint - Light Gray B 5tucco - Red Rough
B Flcorboards - 01 = Paint - Pale Blue Stucco - White Fine
Floorboards - 03 — WPaint - Pale Jade Stucco - White Rough
B Fclizge - Leaves Tree Small Paint - Peach Stucco - Yellow Rough
B Foliage - Wild grapes Paint - Pink Blush Textile - 01
Glass - Blue B raint - Royal Blue WTextle - 02
Glass - Clear Fast Paint - Sand Beige Tiles - Light Brown 150x150 +H
Glass - Lamp WPaint - Sienna Sand W Tiles - Mosaic Blue
Glass - Mirrar Tiles - Tan 250x250 immi
W Grass - Brown B Faint - Ultramarine Violet Tiles - Tan 300x300 1

Surface Catalogs

The additional Surface Catalogue has been expanded for ArchiCAD 19 with now over 500 surfaces
included with your ArchiCAD 19 disc that can be accessed by adding individual surfaces to your file
from the catalog.

There is an additional Catalog of surfaces available exclusively to ARCHICADselect members,
this will be made available on the myCadimage site at My Select Benefits>ArchiCAD Resources:

mMyCadimage | ARCHICADselect Lounge

Premium C4D Surface Catalogue for ArchiCAD 19 & Download

This Premium Surface Catalogue is packaged as a Library. Simply copy it into your
ArchiCAD Library 18 folder.
516 Downloads

& ArchiCAD Resources  {
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Surface Painter

Surfaces in ArchiCAD 19 got expanded and a lot easier to use with the introduction of the new
Surface Painter Palette. You can access this from Window>Palettes >Surface Painter. You must be
in the 3D window to turn the palette on as it can only apply Surfaces in 3D.

Q ‘ Project Surfaces "] ..é IL,

Brick - Commeo... Brick - Flemish ... Brick - Red Brick - Red Her...

For this version of the NZE Template Guide we will describe how to use this new Palette.

The LEFT hand side of the Surface Palette is the Surfaces that are part of your template, this is the
130+ surfaces that are integral to the NZE Template. You can search through these using the
‘Project Surfaces’ search panel highlighted above. This will also search your Surface Catalogs and
BIM Components, you will first need to ‘Add to Project’ before applying the Surface in 3D:

b [ A || 2 | Foundsssufaces@: ) T @ o

¢ P 8
' 4

Brick - Stack B... Glass - Blue Weod - Mahog..

®

Brick - Brown Brick - Commo... Brick-Flemish ... Woed - Pine G... Paint - Titaniu...

From there you just click the Surface you want on the left and either click the face/element you want
to override, or click the selected element surface on the RHS to override all of those surfaces.
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Fills

The NZE Template has over 170 Fills pre-loaded. The Fills are broken into 5 groups
Solid Fills (including % Fills)

Gradient Fills — choose 2 colour fills

Vectorial Fills — use these for larger fill areas
Symbol Fills — generally these fills are very complex, so it is best if possible to use in small

areas; use for detail fills, cut wood, steel etc. When using on driveways, roofs etc, expect

ARCHICAD 19

ArchiCAD to slow slightly and for your PDF’s to be larger file sizes.

Image Fills — these are the same as Surfaces but can be used in 2D i.e. for indicating tiles,

carpet, grass, riverstones, etc. in Plan Views.

Grid 600x600
WECTORIAL FILLS
Scale with plan

[ Background Fil
I Foreground Fil
GRADIENT FILLS

I ] Linear Gradient Fil
[ radial Gradient Fil

Fire Proofing

@I Fire Stripes

Frame Fill 1

Frame Fill 2

Glazed Tile

Grass

H-H rid 150150

HH @rid 250x250

HH @rid 300x300

FZ Grid 50x50 Diagonal

5 styrofoam SM Insulation
Thermal Block
e Trellis
Triangles
BB Triangular Grid
Trim Fill
Trim Fill 2
[T vertical Cladding
B Wood
SYMBOL FILLS

EZ pavement 18
ﬁ Pavement 19
% Pavement 20
% Pavement 21
AT Pavement 22
@ Pavement 23
@ Pavement 24
ﬁ Pavement 25
@ Pavement 26
[EY Pavement 27

VECTORIAL FILLS
= 2v4 stud wall 16 0.C.

B crid a00x 1200
BEE Grid 600x600

(22 Backfil i Pavement 25
E=5 Brick - Common Bond +Mortar 55 Pavement 29
B2 brick - English Bond +Mortar [ Pavement 30

HH @rid 900x900

EEH erick - Stack Bond + Mortar Pebbles
Batt Insulation [T Hexagonal B Brick Flemish Bond +Mortar  EEE River Rock
= Block - Running Bond Insulation E== Brick Running Bond +Mortar  [FH Roof Tile 01
BER Block - Stack Bond [ ] Jwistoz Concrete B39 Roof Tile 02
] Block 200x400 [ Joistoz Concrete 01 B2 Roof Tile 03
{EH Block Floor 1:3 Leaf Fil i Concrete 02 FI-H Roof Tile 04
EMET= - f— .. L . e - . Lrrorron . - M- — -

Zone Categories

All Zones use Zone_Stamp_2 19, this is to utilize the Scale sensitive features, where different
information is shown at different Scales.

L
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Favorites

Favorites give you the ability to save a preset set of settings for any Tool, they can greatly improve
your workflow by eliminating the time you spend to set up standard text or joinery and also have the
benifet of standardizing how certain parts of your documentation looks because of their
consistency. We have set up the NZE Template to include a large range of Favorites to get you
started in using the most efficient workflow while designing. They're easy to access at any point &
save you time setting up so you should become comfortable using them very quickly.

There are 2 main ways to access Favorites:
1. They will always appear at the top left of any settings dialog:

2. Opening the ‘Favorites’ palette at Window > Palettes > Favorites

Favorites n

Mame 4
EXT: 140 Therm... A
EXT: Concrete 1...
EXT: Concrete Bl...
EXT: Stud 140 1...
EXT: Stud 90 Ins...
EXT: Stud 90 MZE

In the example above you can see a list of the default NZ Favorites for the Wall tool for Exterior or
Interior timber framed or concrete walls. To use one you just double click and it will set up the
Composite, Size, Layer, Surface etc and you can just start designing.

=
=
m

o i & 0 &

We have done this for every tool, and the Defaults listed earlier in the document for each of the
tools has all been saved as Favorite so you can easily go back to the default settings if you set
something wrong along the way.

A table of all the Favorites included in the ArchiCAD 19 NZE Template can be found in the
Appendix and we have highlighted those Favorites in bold that are the default for each tool.

Schedules

We have included several Schedules in the ArchiCAD 19 NZE Template which may assist in
Quantity take-off of your BIM model. These Interactive Schedules are standard functionality of
ArchiCAD and are able to extract a great deal of information from the BIM model. The schedules we
have built for you are:

e All Openings Schedule
e FElectrical Legend

e FElectrical Schedule

e Object Inventory

e Wall List

While the Cadimage Door & Window schedule is able to give a visual schedule of your joinery,
ArchiCAD’s Interactive schedule is a ‘live’ view of your model in a scheduled cell format. le: If you
change the width of the door in a schedule it will change the model.

A new type of schedule was introduced for ArchiCAD 19; the Surface Schedule. This allows us to
get the areas of our building elements taking into condition elements that may be covering it.
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Project Indexes

Project Indexes are extremely beneficial to your documentation workflow. They can automatically
produce Sheet Indexes Document Transmittals showing the Revisions of each layout.

There are 5 Project Indexes included with the NZE Template:

E| F'_F-DjEEt Indexes
]{:B Change List

------ I Drawing List

- {5 Issue History

The Change List appears much like the Change Manager palette as part of the Revisions
functionality while the Issue History Project Index behaves much like a Document Transmittal
remember all Issues of documents through the life of the project.

We have automatically placed the Sheet Index onto an A4 sheet at the top of the Layout Book. The
Issue History is placed on separate A4 sheet in the Layout Book.

For that reason there is an A4 Layout with the Issue History Project Index now in the Layout Book:

kssue Hs fory
Esue Shest Rev Sheet Name Change ID
™ . First lssue for Client .-

- WIF  Document Transmittal

- WIP  Ground Floor Sketch Plan

- WIP  Sheet Index

- WIF  SitePlan

- WIF  Ground Floor Flan

- WIF  Ground Floor Presentation Plan
- WIF  Ground Floor Foundation Plan
- WIP  Ground Floor Framing Plan

- WIF  Ground Floor Plumbing Plan
-WIP  Ground Floor Reflected Ceiling Plan
- WIPF  RoofPlan

- WIP  Seclions

- WIF  Blevations

-WIP  Detsils

- WIP  Perspective

01
w0z
02
04
05
06
w7
0s
201
201
401
01

HEEEEHEEEEEHEEEEE

The Sheet Index is described on page 15 while the Issue History index lists only the Layouts that you
add to each Issue.

The Drawing List and View List are great resources to see an overview of your project and how
everything is set up:

Wiaw list
Wiew Mame Layer Combinaton Scale | Structure Cisplay Pen Sst hodel View Opfionson Fencwston Filier [ Cimension
Shest Index — — — MEsing [GAT:ED.. [— 00 MOT [N USE  [—
l==ue History — — — Mesing [GAT:ED.. [— 00 MOT M USE [—
Blecrics| Schedule — 1:50  |Entire Model Mesing [GAT:ED.. [— 00 MOT INUSE  [—
Blecirics| Legend — 1:50  |Entire Model Mesing [GAT:ED.. [— 00 MOT INUSE [—
Ttz ALL 11 Entire Model Mesing [Ceilin... |02 Crating 00 NOT IMUSE [SH NZE
Ground Floor SKETCH ALL 1:50  |Entire Model Mising (GA1:50... [ Buiding Plans Mo Markers  [00 NOT IN USE | S& NFE
30 Document Perspective Shadows  |ALL 150 [Entire Model Mesing {GA1:10... |4 Buiding Plans Mo Markers |00 NOT M USE (S NIE
West Elewation Elzwstions 1:100  |Entire Model Mesing (GA1:10... [0 Elevations 00 MOT INUSE  [5d NZE
South Eleation Elzwstions 1:100  |Entire Model Mesing (GA1:10... [10 Elevations 00 MOT N USE [Sd NZE
East EEvation Elenations 1100 |Entire Model MEesing [GA1:10... [10 Elevations 00 MOT INUSE |56 NZE
horth Elewstion Elzwstions 1:100  |Entire Model MEsing [GA1:1 {0 Elzvations 00 MOT INUSE 5 NFE
Generic Perspective HIL 30 Meodel ALL 1:100 |Entire Model MEsing [GA 00 NOT INUSE |—
Generic Perspadive 30: Model ALL 1:100  |Entire Model Mesing [GAT1:10.. 00 MOT [N USE  [—
GenericAmonometny 30 Model ALL 1:100 _ |Entire Model Mesing [GAT:10... [— 00 MOT M USE [—
30 Document Asrizl Shadows 30 Model ALL 1:200  |Entire Model Mesing [Site NZ.. |07 30 Extrior 00 MOT INUSE [5d NZE
Ground Floor Bracing Flan Plan Bracing 150 Entire Model Mesing (GA1:50... | Buiding Flans No Markers |00 NOT IN USE |5 NFE

It is not intended that these will be used in any documentation but allow you to see all settings.
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Revisions in ArchiCAD

Revisions functionality is set up the same as ArchiCAD 18, we have updated this document to just
show how this has been set up within the template rather than the workflow involved.

The Revision History 19 object has been placed onto all Master Layouts except A4 Portrait:

ReviD | ChiD |Revision Date

This is on the Doc: Revisions layer and is set to show the Revision ID, the Changes (ID &
Name/Description) in that Revision and the Date issued. These headings are modified to reflect
terminology more commonly used in New Zealand. This can be changed in its Object settings:

F=H custom Titles NMEIES
1. () Revision ID (@) Custom ReviD

2. () Change ID (@) Custom ChiD

3. () Change Name (®) Custom Revision

4. () Issue Date (®) Custom Date

While an Issue is open all Revision tables will display a Work in Progress watermark over it.

The Change Tool itself has been set up to start at Change ID of ‘1’. From there the Changes will
grow in alphanumeric order (1,2,3 or A,B,C). No Name has been given to the default Change as this

will be entirely dependant on the first Revision of your Project:

W Change Default Settings ?
Favorites... Default
- @ General
Change ID: |
Change name:

By default every Change cloud placed is going to Create a new Change Entry in the Change
Manager. This functionality works much the same as the Detail tool where you can Create a new
Viewpoint or Place a Linked/Unlinked marker. So if you want to place a cloud in another View that
references the same Revision you need to set this to Place Linked Marker:

Marker type: s———| Create new Change | W

Create new Change

Reference to: RIS e e
Flace unlinked marker
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The Layout Book is set up to Number by Revisions nder ‘Change Numbering in Revisions’:
* Change Numbering in Revisions

() Use Change ID

(@) Mumber by Revisions
The first Revision ID (which we have referred to as RevID) is set up as ‘01’. At the very start you will
want to set your Revision ID correct as all Revisions issued after this will grow alphanumerically.

T MNew Issue ?

D 01
Mame Issue
Issue date Work in Progress

If you want this to start at ‘A’ for the design stage just change it here and that will affect all future
Revision ID’s. You can change your numbering system at any time with the help of a checking in the
‘New Issue’ window called ‘Override Revision ID of all Included Layouts’:

By Default only the Clouds/Markers of the Latest Revision will appear in your Layouts so if you have
drawn clouds and issued the documentation the Clouds associated to that Revision will disappear.

This is set up in the New Issue window also as a drop down menu at the bottom which you can also
change as required:

Changes are made by the new Change tool found at the bottom of the Document Toolbox:

This has been set up to use a Cloud & a Marker by default starting at 1 & using the Revision Pen:

You will noticed that it is on the Doc: Floor Layer. This is so the Revision Cloud only appears in the
View that you have placed it in as it is a 2D element; so should be using the annotation Layer as

| | Show Markers: | of latest Revision only |v| | |

Reference to:
Default Settings @ £ {:f‘ = 1
@ <& Doc: Floor ’l (4 ] "{} ) Basic Change Marker 18 /
D: 1 {3 T |15.0000
Mame: Create new Change W *4'"" .@I,' 201 |1 IR

described in the Layer Matrix and Layer Combination in the Appendix of this document.

There is a ‘Doc: Revisions’ Layer created for the purpose of showing a Revision Cloud in more than
one View. ie. If you draw a Cloud around the whole building and want this to be shown in all Floor
Plans. Otherwise using the Views annotation Layer is Best Practice:

Mo @ Ei 1 Do Revisions / Ny @ Ei 1 Do Floor Framing
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Renovation Tool

The NZE Template has been set up primarily for a new build, for this reason we have included a
Renovation Template now on the ArchiCAD 19 disc that has been designed specifically for
Renovation projects with setup Layer combinations, Views and Layouts.

ARCHICAD 19

That said; we have set-up the Renovation functionality in the standard NZE Template and set up
the Renovation Override Styles correctly so the default template installed by ArchiCAD can be
used with modifications for a Renovation project.

Renovation ﬂ

Default elements:

= o I3

Renovation Filter:
00 MOT IM LISE

=

There are 7 filters set up for the Renovation tool:

Renovation

a Renovaticn Filter Options...

Pen Sets

Partial Structure Display...

Floor Plan Cut Plane...

Floor Plan Scale...

30 Document
Creative Imaging
Schedules and Lists

Project Indexes

r 00 NOT IN USE

01 Existing Plan
02 Demolition Plan
03 After Demclition
r 04 All Works
* 05 Mew Construction
» 06 Proposed Plan
» 07 Finished

Additionally we created the ’00 NOT IN USFE’ filter for all our customers who do not use the
Renovation tool and do not want it affecting their drawings; this filter shows all elements with no
overrides. Each of the other Filters control the status of the 3 Renovation Statuses of all elements

like so:
Existing Demolished New
00 | NOT IN USE Show Show Show
01 | Existing Plan Show Show Hide
02 | Demolition Plan Show Override Hide
03 | After Demolition Show Hide Hide
04 | All Construction Show Override Override
05 | New Construction Show Hide Override
06 | Proposed Plan Override Hide Show
07 | Finished Plan Show Hide Show

The Override options are defined by the Renovation status, this is set up to use the Renovation

Pens, Fills and appropriate surfaces as described in the next page.
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Renovation Overrides
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When one of the statuses of elements is set to Override in the Renovation Filters it uses a

predetermined Override Style which is defined in Document>Set Renovation Filter>Renovation
Filter Options and choose Renovation Override Styles.
Each of the 3 Renovation statuses have their override styles which we have set up to work in
conjunction with the NZE Template Pen Sets and Filters.

The Existing Elements Override Style is used only for the Proposed Plan Filter which fades all the
Existing Elements to white so that only the New elements appear with Fills etc.

Override Styles for:

|:| Line Type

LineMarker Text Color
Fill Type

Fill Foreground Color
Fill Background Color

Surface

& Existing Elements

241|

[ Background Fill

| ] Paint - Titanium white

W

3

3

The Demolished Elements Override Style is used for the Demolish Plan and All Construction so
that all elements in 2D and 3D are highlighted yellow. This has been updated to now turn all lines
dashed and when printed use the ‘Demolition Hatch’ fill in Black & White.

Override Styles for:

Line Type

Line/Marker Text Color
Fill Type

Fill Foreground Color
Fill Background Color

Surface

) Elements to be Demolished

Demolition Hatch
245
248

D Paint - Cadmium Yellow

W

3

The New Elements Override Style is used for the New Construction and All Construction Filters
where all New Elements are highlighted Red in 2D & 3D; this turns Grey in the Printing Pen Sets.

Override Styles for:

|:| Line Type

Line/Marker Text Color
[TFill Type

Fill Foreground Color

Fill Background Color

Surface

T2 New Elements

Dashed

. Paint - Cadmium Ora...
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Project Preferences

In Options>Project Preferences>Working Units we have set all the units to millimetres with zero
decimal points. Angles are set to use decimal degrees with 2 decimal points.

‘@ Madel Unit: | millimeter

Decimals:

% Layout Unit: | millimeter

%9 Angle Unit: | decimal degrees

Angle & Font Size Dedmals in Dialog Boxes:

Mote: Waorking Units set here are effective througheout the project, except for
Dimensions and Calculation Units, which are defined separately on their own
Preferences pages.

 cancel || o

In Options>Project Preferences>Dimensions we have created our own set of dimension
preferences which use millimetres for all dimensions (linear and level), decimal degrees for all
angles and metres squared for areas.

Dimensions W | << Previous Next ==

DIN 4] Store as...
Plain Meter Ik

Plain Millimeter
US Architect Delete

US Builder

S Detailing W

PN T e R i Za“i“z Sample:  0.12m?

Area Caloulations

Unit: meter ) W |
Rounding: off W

[THide Zero Decimals

In Options>Project Preferences>Calculation Units & Rules we have set the Calculation Rules to
use ALL the relevant Building Materials for the 4 Skin types.

NZE Template: A How-To Guide - 52



D%ﬁnition of Listed Skins:

Wall Insulation Skin: Insulation - Fiber; Insulation - Glass Woo

Wall air Skin: Air Space; Air Space - Frame

Roof Insulation Skin: Insulation - Fiber; Insulation - Glass Woo

Shell Insulation Skin: Insulation - Fiber; Insulation - Glass Woao |I|

Cancel QK
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In Options>Project Preferences>Legacy we have turned all Legacy Options OFF. This is to fully
take advantage of ArchiCAD’s new functionality including Priority Based Connections which was

introduced in V17 and the new Interior Elevation tool:

Legacy Options:

IIse Symbualic Display in Floor Plan for Single-plane Roofs and their :
L epights L1

As in ArchiCAD 14 and before

[ ] Use legacy intersection methods for model elements (7 )
As in ArchiCAD 18 and before
Columns vs. Beams global priority: g
] IUse legacy method when creating Interior Elevations with infinite o

Horizontal Range
As in ArchiCAD 17 and before

Mote: Plans previcusly saved in an earlier file format will be opened by ArchiCAD 18
with all the above options automatically enabled.

Find & Select Criteria

We have saved 5 Find and Select Criteria to make it easier selecting those elements that are often
difficult to get, like the boundaries on the edge of a mesh, or Coverings attached to walls. You can
access these from the drop down menu at the top of the Find & Select palette:

All 2D Elements
All 30 Elements
All elements on unlocked and wisiblg

Find & Select B
Criteria Set Mame; All Elements J
Built-in Criteria Sets
Criteria All Elements

Add - Cadimage Boundary + Morth
Cadimage Coverings
Seleced: o Cadimage Objects
Editable: o Cadimage Roof Coverings
Cadimage Wall Coverings
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Operation Profiles

B 2
K Operation Profiles :
Available Operation Profiles
Other habitable rooms (non residential) ] New...
Personal office
Residential
Delete
Restaurant
Qccupancy Data
Occupancy type:

Residential W

MNote: Define "Residential N2 profile’s daily schedules and drag them in the order of precedence.

Daily Schedules Recurrence Date Range In use [hours]

. habitation NZ (M| Every Day |z| All Year |z|

| Add | | Remove | Uncovered: 0

| Edit Daily Schedules... |

| coneel | | ok |

We have created a new Operation profile called Residential NZ to more closely align with typical
New Zealand Residency based on larger NZ homes per capita.

And a new Daily Schedule based on a working family, not at home during the day.

|habitation

habitation NZ

Edit profile data in the selected time period

Internal temperature
- DMam’mum:
0 CIMinimum:

Internal heat gain

. Occupancy count:
40.0000 %mzpﬁ capita

. [ Lighting: Mone

Power:

QEI%"‘ Q%h 0%"‘ .DEquipment:
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Getting Help

Help Menu

The Help menu is your number 1 resource for everything ArchiCAD, Cadimage Tools & the
Template. It is the too-often underused menu despite holding all the answers as to how & why
ArchiCAD operates as it does. It now has even more resources on the disc & a large database
online with the newly improved Graphisoft helpcentre which now has all content from ArchiCAD Wiki,
ArchiCADtalk, Help guide & Youtube:

cm:

Learn Watch Browse Find Read

from guides tutaorials tips & tricks solution for issues technical notes

The PDF’s at the top of the menu give you an offline resource that you can quickly consult and print
for your office use, hence this Template document is included as a PDF. For everything else it is
best to use the Graphisoft Help Centre which can be maintained & updated easily.

Links

The links in the Help menu has also been cleaned up with many of them removed so we just have a
handful of useful links:

¢ ArchiCAD Downloads (this link does not work — I'm not sure where it should go in your new
website)

e ArchiCAD Tutorials (http://archicad.co.nz/learn)

e ArchiCAD Interoperability (http://www.graphisoft.com/archicad/open_bim/)

¢ Design Navigator (http://www.designnavigator.co.nz/)

e ArchiCAD NZ (http://archicad.co.nz)

o Cadimage Tools (www.cadimage.com)

¢ MyCadimage (www.mycadimage.com)
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Section Three: Renovation Template

The Renovation Template has been based off the standard NZE Template supplied with ArchiCAD
19 & has been developed by Cadimage Group especially for ArchiCAD customers within New
Zealand. This part of the document is designed to outline the differences & how to effectively use
this template.

As aresult, a lot of the template is the same and not covered in this document. To review the full
settings please consult the ArchiCAD 19 NZE Template document. These unaltered settings
include:

Project Map

Master Layouts
Keyboard Shortcuts
Default Functions
Filter Elements in 3D
The Toolbox

Floor Plan Display
Model View Options
Building Materials
Composites
Complex Profiles
Zones

Schedules etc
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Renovation View Map &=

The View Map is the biggest difference between the standard NZE Template and the Renovation
Template as it brings together all of the new Layers & Renovation Filters to automatically create a
full set of Views for every aspect of your design at each stage.

The View Map has been set up in two tiers like so:

1. The type of Drawing (Plan/Section/Elevation)
2. The Renovation stage of that Drawing

The Site folder has 3 folders & 6 Views based on the 0.Sea Level/Datum story at 1:200 Scale with
different Layer combinations & Renovation Filters:

o Existing
o Exiting Site Plan — Uses the Existing Plan Site Layer combination and 01 Existing
Plan Renovation Filter, this is placed on the Existing Site Plan Layout
e Demolition
o Demolition Site Plan — Uses the Demolition Plan Site Layer combination and 02
Demolition Plan Renovation Filter, this is not placed on a Layout
e Proposed
o Proposed Site Plan — Uses the Proposed Plan Site Layer combination and 06
Proposed Plan Renovation Filter, this is placed on the Proposed Site Plan Layout
o Proposed Site Bulk & Location — Uses the Proposed Plan Site Bulk & Location
Layer combination and 06 Proposed Plan Renovation Filter, this is not placed on a
Layout.
o Proposed Site Landscaping- Uses the Proposed Plan Site Landscaping Layer
combination and 06 Proposed Plan Renovation Filter, this is not placed on a Layout
o Proposed Site Site Services — Uses the Proposed Plan Site Services Layer
combination and 06 Proposed Plan Renovation Filter, this is not placed on a Layout
e As-Built
o As-Built Site Plan — Uses the Proposed Plan Site Layer combination and 07 As Built
Renovation Filter, this is not placed on a Layout

The Plans folder are all based on the 1.Ground Floor Story except for the Roof Plans which is
based on the 2.Roof Story and are at 1:50 Scale each using the following setup:

e Ground Floor SKETCH ALL - Uses the ALL Layer Combination & 00 NOT IN USE
Renovation Filter to easily model all aspects of the design so is not placed on a Layout.

e Existing
o Existing Ground Floor Plan — Uses the Existing Plan Floor Layer combination and
01 Existing Plan Renovation Filter; this is placed on the Existing Ground Floor Plan
Layout
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o Demolition Ground Floor Plan — Uses the Demolition Plan Floor Layer combination
and 02 Demolition Plan Renovation Filter; this is placed on the Demoalition Ground
Floor Plan Layout

o Demolition Ground Floor Interior — Uses the Demolition Plan Room Interior Layer
combination and 02 Demolition Plan Renovation Filter; this is not placed on a Layout

o Demolition Ground Floor Framing Plan — Uses the Demolition Plan Floor Framing
Layer combination and 02 Demolition Plan Renovation Filter; this is not placed on a
Layout

o Demolition Ground Floor Plumbing Plan — Uses the Demolition Plan Plumbing
Layer combination and 02 Demolition Plan Renovation Filter; this is not placed on a
Layout

o Demolition Roof Plan — Uses the Demolition Plan Roof Layer combination and 02
Demolition Plan Renovation Filter; this is not placed on a Layout

o Demolition Roof Framing — Uses the Demolition Plan Roof Framing Layer
combination and 02 Demolition Plan Renovation Filter; this is not placed on a Layout

e Proposed

o Proposed Ground Floor Plan - This uses the Proposed Plan Floor Layer
combination and 06 Proposed Plan Renovation Filter; this is placed on the Proposed
Ground Floor Plan Layout.

o Proposed Ground Floor Presentation - This uses the Proposed Plan
Presentation/Furniture Layer combination and 06 Proposed Plan Renovation Filter;
this is placed on the Proposed Ground Floor Plan Layout.

o Proposed Ground Floor Electrical Plan - This uses the Proposed Plan Electrical
Layer combination and 06 Proposed Plan Renovation Filter; this is placed on the
Proposed Ground Floor Electrical Plan Layout.

o Proposed Ground Floor Bracing Plan - This uses the Proposed Plan Bracing Layer
combination and 06 Proposed Plan Renovation Filter; this is not placed on a Layout.

o Proposed Ground Floor Framing Plan - This uses the Proposed Plan Floor
Framing Layer combination and 06 Proposed Plan Renovation Filter; this is not
placed on a Layout.

o Proposed Ground Floor Plumbing Plan - This uses the Proposed Plan Plumbing
Layer combination and 06 Proposed Plan Renovation Filter; this is placed on the
Proposed Ground Floor Plumbing Plan Layout.

o Proposed Ground Floor RCP - This uses the Proposed Plan Reflected Ceiling
Layer combination and 06 Proposed Plan Renovation Filter; this is placed on the
Proposed Ground Floor RCP Layout.

o Proposed Foundation Plan - This uses the Proposed Plan Foundation Layer
combination and 06 Proposed Plan Renovation Filter; this is placed on the Proposed
Foundation Plan Layout.

o Proposed Roof Plan- This uses the Proposed Plan Roof Layer combination and 06
Proposed Plan Renovation Filter; this is placed on the Proposed Roof Plan Layout.

o Proposed Roof Framing - This uses the Proposed Plan Floor Layer combination
and 06 Proposed Plan Renovation Filter; this is placed on the Proposed Roof

Framing Layout.
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o As-Built Ground Floor Plan — Uses the Proposed Plan Floor Layer combination and
07 As Built Renovation Filter, this is placed on the As-Built Ground Floor Plan Layout

o Proposed Ground Floor Plan - This uses the Proposed Plan Floor Layer
combination and 06 Proposed Plan Renovation Filter; this is placed on the Proposed
Ground Floor Plan Layout

The Sections Folder is empty as Sections are specific to your Design, when you place a Section
simply create the Views in the appropriate folder (Existing/Proposed)

The Elevations Folder contains 4 Elevations looking at direct North, East, South at West of the
Design and are set to 1:100 scale so all 4 can be placed on one Layout. There are 2 folders:

e Existing Elevations — Uses the Existing Elevations Layer combination and 01 Existing Plan
Renovation Filter. All 4 Existing Elevations are placed on the Existing Elevations Layout

e As-Built Elevations — Uses the Proposed Elevations Layer combination and 07 As-Built
Renovation Filter; these are placed on the As-Built Elevations Layout.

The Details Folder is empty as these are also specific to your Design, when Detail Views are
created; place them within this folder.

The 3D Folder contains 4 folders for the different Renovation stages of the BIM Model. All of these
contain a Generic Perspective View set with the appropriate Renovation Status as all 3D elements
are affected by the Renovation Filter. The As-Built Folder contains all the Views typically found in
the NZE template and are all set to the 07 As-Built Renovation Filter.

The Title Blocks Folder contains the same Title Block found in the standard NZE Template.

The Schedules Folder contains two schedules for Electrical items:

e Electrical Legend — This schedule looks for all Objects placed on the Des: Fittings Electrical
or Des:Lamps Layers and shows the Floor Plan symbol. It has been updated to only show
elements with a New Renovation Status so as to not schedule existing elements.

e Electrical Schedule - This schedule looks for all Objects on the Des: Fittings Electrical,

Doc: Electrical or Des:Lamps Layers showing the physical 3D Wall Plate model and has
been updated to only show elements with a New Renovation Status also.

The Indexes Folder contains the same Indexes found in the standard NZE Template.
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Renovation Layout Book &2

The Layout Book in the Renovation template has been organized in terms of Renovation Filters and
is based directly off the View Map, so a lot of the views listed above are placed individually onto
Layouts using the Scale & Layer combination of the Views, while using the relevant Printing Pen
Set to issue the documents in Black & White.

ARCHICAD 19

‘...[?g Ground Floor SKETCH ALL
El Ge:osmg

(=-[) Demolition

..... [ Demolition Ground Floor Plan

..... [ Demolition Ground Floor Interior

..... [ Demolition Ground Floor Framing Plan

----- [ Proposed Roof Framing
e- [j As-Built

------ [3 As-Built Ground Floor Plan
- Sections

-)-[_]) Elevations

- () Existing
@-[) As-Built
[ Details

J-[@ 30

- () Exsting

E Document Transmittal
£)-{r) Existing Conditions
" i (- (8 Existing Site Plan

A | | Tree by subset ’

=g Untitied
(-8 Sheet Index

- (+)- (8 Existing Ground Floor Plan
. (+)-[3 Existing Elevations
El {a Demolition
# (-8 Demolition Ground Floor Plan
" G Proposed
w13 Proposed Site Plan
- (-3 Proposed Ground Floor Plan
. +-[8 Proposed Ground Floor Presentation
.- [@ Proposed Ground Floor Electrical Plan
[+ (8 Proposed Ground Floor Plumbing Plan
(- [@ Proposed Ground Floor RCP
_+-[8 Proposed Foundation Plan
(#- 8 Proposed Roof Plan
- -[[8 Proposed Roof Framing
B- ﬁﬁseudt
- [C3 As-Built Ground Floor Plan
e +1-[(8 As-Built Elevations

E As-Built Perspective
E b G4 1 Generic Perspective
(- Masters
i+ [IB A4 Portrait
-8 A3 Landscape
&-HB A2 Landscape
(@8 A1 Landscape

\‘ R — = <
S . S . A A IS
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Layers

The Layers in NZE Template have been developed to be as simple as possible aligning their
names with the Toolbox and Tools. The Renovation Template uses these same principles. The full
detail of Layers can be found on page 27.

However due to limitations of the Renovation Filters we have created several extra Layers to
produce the typical Renovation documentation with the combined use of Layer control & Renovation
Filters. These extra Layers include:

¢ Doc: Details Existing - For Detail Markers seen on the main Existing Views.
o Doc: Details New - For Detail Markers seen on the main Proposed Views
o Doc: Elevations Existing - For Elevations showing only the Existing Views

e Doc: Elevations New - For Elevations showing the new Proposed Design

e Doc: Existing & Demolition - To annotate existing conditions & Demoalition notes
e Doc: Sections Existing - For Sections showing only in the Existing Views

e Doc Sections New - For Sections going through Proposed Design

An updated Layer Matrix has been included in this Renovation section of the document.

Layer Combinations

The Layer Combinations are based off the possible outputs of documentation you may require.
The result being that every View has its own specific Layer combination

The Layer Combinations have been organised into the Renovation Filters. This is so the Layer
Combinations are named appropriately and match the Views in the View Map that use them.

7. Proposed - These Layer Combinations hide any ‘Existing’/’Demolition’ layers
8. Demolition - These Layer Combination hide any ‘New’ Layers
9. Existing - These Layer Combinations hide any ‘Demolition’/'New’ layers
Some Drawings generally do not require Renovation control so these have not been split out:
10. Details - This single Layer Combination is for use for Detail Views
11. Interior Elevations - This single Layer Combination is for use for Interior Elevations

12. Key - This single Layer Combination is for producing a Key Plan

The Proposed set is the most extensive as this is expected to account for the majority of the
documentation. There is quite a range of Demolition & Existing Layer Combinations and Views
giving you the option to easily document this aspect though are not automatically placed on
Layouts.
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Pens

The Renovation Template uses the same 8 pen sets used in the standard NZE template with a
few modifications. To read more on the function & set up of the Pen Sets please read the ArchiCAD
19 NZE Template document.

The modifications are very slight and are made to darken the Renovation Pens when documenting
using the Printing Pen Sets only. The Colour pens used on screen are the same. Below are the
slight difference between the original Printing Pen Set and the new Renovation Pens:

To accommodate other workflows there is a new pen added at 250 which is highlighted above in the
right hand side Renovation Pens. This can be used as a Building Material background pen to give
Building Materials such as Concrete or Masonry a solid appearance on Plan like so:

The main reason for this change is so the Renovation Overrides will only Override the Fill
background pen to differentiate Existing Elements from New Elements in the Proposed Plan but
both still have their Fill content to appear the same as Existing Plans. In the standard Renovation
Template the existing Elements are turned solid white while the New elements have Fills.

Pen Sets

There are 10 Pen Sets in the Renovation Template, 8 are the same as the standard NZE Template.
The additional 2 Templates are for Presentation purposes. They are a duplicate of the GA 1:50 and
1:100 Printing Pen Sets and have their 9 Renovation Pens set to Colour for Colour printing
purposes. These are not used by default but there as an option.

N |
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..!|!|!|!|!|!l!|! [ [ [ [ [ Trrrr
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Fills

The Fills are the same as the NZE Template which now includes Demolition Hatch. This is set up to
be large scale & use the Demolition Pen. It is stored as Demolition Hatch NZE favorite.

L4 # 244
... D Demolition Hatch w3 2
’ L BRRE
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Section Four: Appendix

In this section, you will find tables of the attributes in both templates like:

Pen Table

Favorites List
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Pen Table
Pen # Pen Name Detailing | GA1:50 | GA1:100 | Site
1 General - General 0.18 0.13 0.1 0.1
2 2D Elements - General 0.25 0.18 0.13 0.1
3 Openings - General 0.25 0.18 0.13 0.1
4 Obijects - General 0.25 0.18 0.13 0.1
5 Annotation - General 0.35 0.25 0.18 0.13
6 Annotation Text - general 0.5 0.35 0.25 0.18
7 Wallls - General 0.25 0.18 0.13 0.1
8 Columns - General 0.25 0.18 0.13 0.1
9 Slabs - General 0.25 0.18 0.13 0.1
10 Beams - General 0.25 0.18 0.13 0.1
11 Stairs - General 0.25 0.18 0.13 0.1
12 Roof - General 0.25 0.18 0.13 0.1
13 Mesh - general 0.25 0.18 0.13 0.1
14 Zone - General 0.25 0.18 0.13 0.1
15 Mechanical - general 0.25 0.18 0.13 0.1
16 Structural - general 0.25 0.18 0.13 0.1
17 Electrical - general 0.25 0.18 0.13 0.1
18 Fills - color 1 0.35 0.25 0.18 0.13
19 Backgrounds - color 1 0.25 0.18 0.13 0.1
20 Symbols General 0.35 0.25 0.18 0.13
21 General - Cut Structural 0.7 0.5 0.35 0.25
22 2D Elements - Cut Structural 0.7 0.5 0.35 0.25
23 Openings- Cut Structural 0.7 0.5 0.35 0.25
24 Objects - Cut Structural 0.7 0.5 0.35 0.25
25 Annotation - Markers 0.7 0.5 0.35 0.25
26 Annotation Text - header 0.7 0.5 0.35 0.25
27 Walls - Cut Structural 0.5 0.35 0.25 0.18
28 Columns - Cut Structural 0.7 0.5 0.35 0.25
29 Slabs - Cut Structural 0.7 0.5 0.35 0.25
30 Beams - Cut Structural 0.7 0.5 0.35 0.25
31 Stairs - Cut Structural 0.7 0.5 0.35 0.25
32 Roof - Cut Structural 0.7 0.5 0.35 0.25
33 Mesh - Cut Structural 0.7 0.5 0.35 0.25
34 Zone - Cut Structural 0.7 0.5 0.35 0.25
35 Mechanical - Hot Water 0.5 0.35 0.25 0.18
36 Structural - Cut Construction 0.7 0.5 0.35 0.25
37 Electrical - Power Grid 0.5 0.35 0.25 0.18
38 Fills - color 2 0.35 0.25 0.18 0.13
39 Backgrounds - color 2 0.25 0.18 0.13 0.1
40 Symbols General - color 2 0.35 0.25 0.18 0.13
41 General -Cut Non-Structural 0.5 0.35 0.25 0.18
42 2D Elements - Cut Non-Structural 0.5 0.35 0.25 0.18
43 Openings- Cut Non-Structural 0.5 0.35 0.25 0.18
44 Obijects - Cut Non-Structural 0.5 0.35 0.25 0.18
45 Annotation - Arrowheads 0.5 0.35 0.25 0.18
46 Annotation text - bold 0.5 0.35 0.25 0.18
47 Wallls - Cut Non-Structural 0.5 0.35 0.25 0.18
48 Columns - Veneer 0.5 0.35 0.25 0.18
49 Slabs - Cut Non-Structural 0.5 0.35 0.25 0.18
50 Beams - Cut Non-Structural 0.5 0.35 0.25 0.18
51 Stairs - Cut Non-Structural 0.5 0.35 0.25 0.18
52 Roof - Cut Non-Structural 0.5 0.35 0.25 0.18
53 Mesh - Cut Non-Structural 0.5 0.35 0.25 0.18
54 Zone - Cut Non-Structural 0.5 0.35 0.25 0.18
55 Mechanical - Cold Water 0.35 0.25 0.18 0.13
56 Structural - Cut Non-Construction 0.35 0.25 0.18 0.13
57 Electrical - Switchboards 0.35 0.25 0.18 0.13
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Pen # Pen Name Detailing | GA1:50 | GA1:100 | Site
58 Fills - color 3 0.35 0.25 0.18 0.13
59 Backgrounds - color 3 0.25 0.18 0.13 0.1
60 Symbols General - color 3 0.35 0.25 0.18 0.13
61 General - Symbols and Separators 0.25 0.18 0.13 0.1
62 2D Elements - Symbols and Separators 0.25 0.18 0.13 0.1
63 Openings- Symbols and Separators 0.25 0.18 0.13 0.1
64 Objects - Symbols and Separators 0.25 0.18 0.13 0.1
65 Annotation - Frames 0.25 0.18 0.13 0.1
66 Annotation Text - normal 0.25 0.18 0.13 0.1
67 Walls - Symbols and Separators 0.25 0.18 0.13 0.1
68 Columns - Symbols and Separators 0.25 0.18 0.13 0.1
69 Slabs - Symbols and Separators 0.25 0.18 0.13 0.1
70 Beams - Symbols and Separators 0.25 0.18 0.13 0.1
71 Stairs - Symbols and Separators 0.25 0.18 0.13 0.1
72 Roof - Symbols and Separators 0.25 0.18 0.13 0.1
73 Mesh - Ridges 0.25 0.18 0.13 0.1
74 Zone - Symbols 0.25 0.18 0.13 0.1
75 Mechanical - Plumbing 0.25 0.18 0.13 0.1
76 Structural - Text and Symbols 0.25 0.18 0.13 0.1
77 Electrical - General Lighting 0.25 0.18 0.13 0.1
78 Fills - color 4 0.35 0.25 0.18 0.13
79 Backgrounds - color 4 0.25 0.18 0.13 0.1
80 Symbols General - color 4 0.35 0.25 0.18 0.13
81 General - Outlines and Cover fills 0.25 0.18 0.13 0.1
82 2D Elements - Outlines 0.25 0.18 0.13 0.1
83 Openings- Uncut/Overhead 0.25 0.18 0.13 0.1
84 Objects - Uncut and Overhead 0.25 0.18 0.13 0.1
85 Annotation - Dimlines 0.25 0.18 0.13 0.1
86 Annotation text - notes 0.25 0.18 0.13 0.1
87 Walls - Outlines 0.25 0.18 0.13 0.1
88 Columns - Outlines 0.25 0.18 0.13 0.1
89 Slabs - Outlines and Cover Fills 0.25 0.18 0.13 0.1
90 Beams - Outlines 0.25 0.18 0.13 0.1
91 Stairs - Outlines 0.25 0.18 0.13 0.1
92 Roof - Outlines and Cover Fills 0.25 0.18 0.13 0.1
93 Mesh - Outlines and Cover Fills 0.25 0.18 0.13 0.1
94 Zone - Outline and Cover Fill 0.25 0.18 0.13 0.1
95 Mechanical - Gas 0.25 0.18 0.13 0.1
96 Structural - Outlines 0.25 0.18 0.13 0.1
97 Electrical - IT Networks 0.25 0.18 0.13 0.1
98 Fills - color 5 0.35 0.25 0.18 0.13
99 Backgrounds - color 5 0.25 0.18 0.13 0.1
100 Symbols General - color 0.35 0.25 0.18 0.13
101 General - Cut Fills 0.18 0.13 0.1 0.1
102 2D Elements - Drafting 0.18 0.13 0.1 0.1
103 Openings- Cut Fills 0.18 0.13 0.1 0.1
104 Objects - Cut Fills 0.18 0.13 0.1 0.1
105 Annotation - Thin 0.18 0.13 0.1 0.1
106 Annotation Text - markup 0.18 0.13 0.1 0.1
107 Walls - Cut Fills 0.18 0.13 0.1 0.1
108 Columns - Cut Fills 0.18 0.13 0.1 0.1
109 Slabs - Cut Fills 0.18 0.13 0.1 0.1
110 Beams - Cut Fills 0.18 0.13 0.1 0.1
111 Stairs - Cut Fills 0.18 0.13 0.1 0.1
112 Roof - Cut Fills 0.18 0.13 0.1 0.1
113 Mesh - Cut Fills 0.18 0.13 0.1 0.1
114 Zone - Cut Fills 0.18 0.13 0.1 0.1
115 Mechanical - Equipment 0.18 0.13 0.1 0.1
116 Structural - Hatching 0.18 0.13 0.1 0.1
117 Electrical - Equipment 0.18 0.13 0.1 0.1
118 Fills - color 6 0.35 0.25 0.18 0.13
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Pen # Pen Name Detailing | GA1:50 | GA1:100 | Site
119 Backgrounds - color 6 0.25 0.18 0.13 0.1
120 Symbols General - color 0.35 0.25 0.18 0.1
121 General- backgrounds 0 0 0 0
122 2D Elements - Fill backgrounds 0 0 0 0
123 Openings- Fill backgrounds 0 0 0 0
124 Obijects - Fill Backgrounds 0 0 0 0
125 Annotation - Backgrounds 0 0 0 0
126 Cut Elements- opaque backgrounds 0 0 0 0
127 Walls - Fill backgrounds 0 0 0 0
128 Columns - Fill backgrounds 0 0 0 0
129 Slabs - Fill backgrounds 0 0 0 0
130 Beams- fill backgrounds 0 0 0 0
131 Stairs- fill backgrounds 0 0 0 0
132 Roofs- Fill backgrounds 0 0 0 0
133 Mesh- fill backgrounds 0 0 0 0
134 Zones- Fill backgrounds 0 0 0 0
135 Mechanical- backgrounds 0 0 0 0
136 Structural - fill backgrounds 0 0 0 0
137 Electrical - fill backgrounds 0 0 0 0
138 Fills - color 7 0.35 0.25 0.18 0.13
139 Backgrounds - color 7 0.25 0.18 0.13 0.1
140 Hotspots - color 0.35 0.25 0.18 0.13
141 Membranes - Cut Lines 0.5 0.35 0.25 0.18
142 Plastic membranes - Cut Lines 0.5 0.35 0.25 0.18
143 Masonry blocks - Cut Lines 0.7 0.5 0.35 0.25
144 Tiling - Floor & Wall - Cut Lines 0.35 0.25 0.18 0.13
145 Glass - Cut Lines 0.25 0.18 0.13 0.1
146 Metals - Cut Lines 0.25 0.18 0.13 0.1
147 Ironwork - Cut Lines 0.7 0.5 0.35 0.25
148 Brickwork - Cut Lines 0.5 0.35 0.25 0.18
149 Lightweight Concrete - Cut Lines 0.5 0.35 0.25 0.18
150 Reinforced concrete - Cut Lines 0.7 0.5 0.35 0.25
151 Solid plastics - Cut Lines 0.25 0.18 0.13 0.1
152 Tiles - Roof - Cut Lines 0.35 0.25 0.18 0.13
153 Earth - Cut Lines 0.7 0.5 0.35 0.25
154 Thermal Insulation - Cut Lines 0.25 0.18 0.13 0.1
155 Timber - Cut Lines 0.5 0.35 0.25 0.18
156 Plasters - Cut Lines 0.35 0.25 0.18 0.13
157 Gypsum - Cut Lines 0.25 0.18 0.13 0.1
158 Stones - Cut Lines 0.5 0.35 0.25 0.18
159 Air Space - Cut Lines 0.25 0.18 0.13 0.1
160 Particle - Cut Lines 0.35 0.25 0.18 0.13
161 Membranes - Cut Fills 0.18 0.13 0.1 0.1
162 Plastic membranes - Cut Fills 0.18 0.13 0.1 0.1
163 Masonry blocks - Cut Fills 0.18 0.13 0.1 0.1
164 Tiling - Floor & Wall - Cut Fills 0.18 0.13 0.1 0.1
165 Glass - Cut Fills 0.18 0.13 0.1 0.1
166 Metals - Cut Fills 0.18 0.13 0.1 0.1
167 Ironwork - Cut Fills 0.18 0.13 0.1 0.1
168 Brickwork - Cut Fills 0.18 0.13 0.1 0.1
169 Lightweight Concrete - Cut Fills 0.18 0.13 0.1 0.1
170 Reinforced concrete - Cut Fills 0.18 0.13 0.1 0.1
171 Solid plastics - Cut Fills 0.18 0.13 0.1 0.1
172 Tiles - Roof - Cut Fills 0.18 0.13 0.1 0.1
173 Earth - Cut Fills 0.18 0.13 0.1 0.1
174 Thermal Insulation - Cut Fills 0.18 0.13 0.1 0.1
175 Timber - Cut Fills 0.18 0.13 0.1 0.1
176 Plasters - Cut Fills 0.18 0.13 0.1 0.1
177 Gypsum - Cut Fills 0.18 0.13 0.1 0.1
178 Stones - Cut Fills 0.18 0.13 0.1 0.1
179 Air Space - Cut Fills 0.18 0.13 0.1 0.1
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Pen # Pen Name Detailing | GA1:50 | GA1:100 | Site
180 Particle - Cut Fills 0.18 0.13 0.1 0.1
181 0.01 Pen 0.01 0.01 0.01 0.01
182 0.13 Pen 0.13 0.13 0.13 0.13
183 0.18 Pen 0.18 0.18 0.18 0.18
184 0.25 Pen 0.25 0.25 0.25 0.25
185 0.35 Pen 0.35 0.35 0.35 0.35
186 0.5 Pen 0.5 0.5 0.5 0.5
187 0.7 Pen 0.7 0.7 0.7 0.7
188 1.0 Pen 1 1 1 1
189 2.0 Pen 2 2 2 2
190 3.0 Pen 3 3 3 3
191 5% Grey 0.1 0.1 0.1 0.1
192 10% Grey 0.1 0.1 0.1 0.1
193 20% Grey 0.1 0.1 0.1 0.1
194 30% Grey 0.1 0.1 0.1 0.1
195 40% Grey 0.1 0.1 0.1 0.1
196 50% Grey 0.1 0.1 0.1 0.1
197 60% Grey 0.1 0.1 0.1 0.1
198 70% Grey 0.1 0.1 0.1 0.1
199 80% Grey 0.1 0.1 0.1 0.1
200 90% Grey 0.1 0.1 0.1 0.1
201 Revisions 0.25 0.25 0.25 0.25
202 Twink 0.25 0.25 0.25 0.25
203 Thick Twink 1 1 1 1
204 user defined 0 0 0 0
205-219 | user defined 0 0 0 0
220 user defined 0 0 0 0
221 Colour Pen 0.1 0.1 0.1 0.1
222 Colour Pen 0.1 0.1 0.1 0.1
223 Colour Pen 0.1 0.1 0.1 0.1
224 Colour Pen 0.1 0.1 0.1 0.1
225 Colour Pen 0.1 0.1 0.1 0.1
226 Colour Pen 0.1 0.1 0.1 0.1
227 Colour Pen 0.1 0.1 0.1 0.1
228 Colour Pen 0.1 0.1 0.1 0.1
229 Colour Pen 0.1 0.1 0.1 0.1
230 Colour Pen 0.1 0.1 0.1 0.1
231 Presentation Pen - Grass 0.1 0.1 0.1 0.1
232 Presentation Pen - Plants 0.1 0.1 0.1 0.1
233 Presentation Pen - Blue 0.1 0.1 0.1 0.1
234 Presentation Pen - Red 0.1 0.1 0.1 0.1
235 user defined 0 0 0 0
236-239 | user defined 0 0 0 0
240 user defined 0 0 0 0
241 Reno Exist - General 0.25 0.25 0.25 0.25
242 Reno Exist - Cut Fills 0.25 0.25 0.25 0.25
243 Reno Exist - Fill Backgrounds 0.25 0.25 0.25 0.25
244 Reno Demo - General 0.25 0.25 0.25 0.25
245 Reno Demo - Cut Fills 0.25 0.25 0.25 0.25
246 Reno Demo - Fill Backgrounds 0.25 0.25 0.25 0.25
247 Reno New - General 0.25 0.25 0.25 0.25
248 Reno New - Cut Fills 0.25 0.25 0.25 0.25
249 Reno New - Fill Backgrounds 0.25 0.25 0.25 0.25
250 user defined 0 0 0 0
251 user defined 0 0 0 0
252 user defined 0 0 0 0
253 user defined 0 0 0 0
254 user defined 0 0 0 0
255 user defined 0.1 0.1 0.1 0.1
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Favorites List

Design Tools

Wall EXT: 140 Thermal Pb NZE Object Armchair NZE
Basin 600x450 NZE

EXT: Concrete 150 NZE Basin Pedestal 600x450 NZE
EXT: Concrete Block 200 NZE Bath 100x750 NZE
EXT: Stud 140 Insul Pb NZE Bed Double 1350x1880 NZE
EXT: Stud 90 Insul Pb NZE Bed King 1650x2030 NZE
EXT: Stud 90 NZE Bed King Single 1070x2030 NZE
EXT: Stud 90 Pb NZE Bed Queen 1500x2030 NZE
INT: Stud 70 NZE Bed Single 920x1880 NZE
INT: Stud 70 Pb NZE Bed Single XL 920x2030 NZE
INT: Stud 90 Insul Pb NZE Bed Super King 1830x2030 NZE
INT: Stud 90 NZE Car Hatchback NZE
INT: Stud 90 Pb NZE Car Saloon NZE
Stud 90 Wall NZE Cooktop Electric NZE

Door 90 Int Door NZE Fridge 600x600 NZE
Acd Lounge Suite NZE
Empty Door NZE Shower Corner 1000sq NZE
Garage Door NZE WC NZE

Window Acw Zone Building Zone NZE
Empty Opening NZE Impermeable Zone NZE
Window NZE Site Zone NZE

Column 250UC NZE Zone NZE
Conc 300sg NZE Mesh Mesh NZE

Timber 90sq NZE

Timber Pile 125sq NZE
Beam 140x90 Exterior Beam NZE
140x90 Interior Beam NZE
Slab Edge Thickening NZE
Slab Foundation Footing NZE
Slab Foundation NZE

Slab Pod 100 rib NZE

Slab Pod 300 rib NZE

Slab Pod Edge NZE

Slab Thickening NZE

Slab 100 Conc Slab Insul NZE
100 Conc Slab NZE

190/20 Timber Insul B/L NZE
190/20 Timber NZE

Conc Pod Slab NZE
Variable Conc NZE

Stair Dog Leg Stair NZE

L-shape Stair NZE

Straight Flight NZE

Roof Ceiling Insul NZE
Ceiling NZE
Roof 90 Insul NZE
Roof 90 NZE
Variable Roof NZE
Shell Shell NZE
Skylight Skylight NZE
Curtain walll Curtain Wall NZE
Morph Morph NZE
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Document Tools More Tools
Dimension Dimension NZE Grid Grid NZE
Section Levels NZE Wall End Partition NZE

Level Dimension | Level NZE Structural NZE
Text 10mm Text NZE Corner Window Left Corner Window NZE
2.5mm Text NZE Right Corner Window NZE
5mm Text NZE Lamp Halogen DL NZE
Label Label NZE Lightworks Sky NZE
Fill 600x600 Fill NZE Radial Dimension Radial NZE
Carpet Image Fill NZE Angle Dimension Angle NZE
Line Line NZE Spline Spline Arrow NZE
Line Zone Boundary NZE Spline NZE
SS Line NZE Hotspot Hotspot NZE
SW Line NZE
Arc/Circle Arc/Circle NZE
Polyline Polyline Arrow NZE
Polyline NZE
Polyline Zone Boundary NZE
Drawing Drawing NZE
Layout 1:50 NZE
Section Section Model Pens NZE
Section Uniform Cut Pens NZE
Elevation Elev Colour NZE
Elev NZE

Interior Elevation

Interior Elev Colour NZE

Interior Elev NZE

Worksheet Worksheet NZE
Detail Detail NZE
Change Cloud + Marker NZE

Cloud Only NZE

Marker Only NZE
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